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About the Tutorial

VersionOne is a project management tool used to trackand maintain records of all STLC phases
in Agile from backlog to report creation. This is a brief tutorial that introduces the readers to
the basic features and usages of VersionOne. The tutorial will guide the users on how to utilize
the tool in reporting and maintain the testing activities.

Audience

This tutorial has been prepared for beginners to help them understand how to use the
VersionOne tool.

Prerequisites

As a reader of this tutorial, you should have a basic understanding of bug and testing lifecycle.

Copyright &Disclaimer

© Copyright 2015 by Tutorials Point (I) Pvt. Ltd.

All the content and graphics published in this e-book are the property of Tutorials Point (I) Pvt.
Ltd. The user of this e-book is prohibited to reuse, retain, copy, distribute or republish any
contents or a part of contents of this e-book in any manner without written consent of the
publisher.

We strive to update the contents of our website and tutorials as timely and as precisely as
possible, however, the contents may contain inaccuracies or errors. Tutorials Point (I) Pvt. Ltd.
provides no guarantee regarding the accuracy, timeliness or completeness of our website or
its contents including this tutorial. If you discover any errors on our website or in this tutorial,
please notify us at contact@tutorialspoint.com
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1. VersionOne — Introduction

VersionOne is a web-based project management tool used by testers, developers and other
stake holders to manage, track and organize software testing efforts. It follows and covers full
life cycle of Agile Methodologies. It supports from first step as Product Backlog to the project’s
final step as completion and delivery.

Interesting Points

VersionOne supports a wide range of functionalities and is one of the best available project
management tools for Agile. VersionOne is joining CollabNet to bring DevOps into the table.

Following are a few interesting facts about VersionOne:

VersionOne helped to bring the Agile Management tool in 2002.
e \VersionOne is also known as the Agile Management tool.
e It is developed and copyright by VersionOne Inc.

e VersionOne is a web based tool that supports all browsers especially Chrome, Firefox,
IE etc.

e It supports different windows OS like Windows XP, Vista, 7, Mac, etc.

e VersionOne provides 30days trial period.

e It supports all phases of planning, scheduling, collaborating, tracking and reporting for
projects, releases, iterations, epics, stories, defects, tasks, tests, teams and team

members.

e VersionOne was named as one of the Best Places to Work by the Atlanta Business
Chronicle.

e Now, CollabNet and VersionOne have merged to accelerate innovation across Enterprise
Software Development and Delivery in 2017.

e VersionOne can be customized using various methodologies such as SAFe, Scrum,
Kanban, Lean, XP, and DAD.

License and Free Tral

VersionOne is used at commercial level across various software industries. It allows the new
users to go through the tool by providing limited free access. In this section, we will see how
VersionOne connects with different user groups at personal and commercial level:
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VersionOne is a commercial tool and available as Trial version for a limited period of 30
days. For personal use, a user can register and get a hands-on experience of
VersionOne.

To utilize VersionOne services, a license is required. After 30 days, if a user wants to
continue using VersionOne, a license is required. By purchasing one of the products,
VersionOne provides license key to continue for a certain time period based on purchase
agreements.

VersionOne provides free license for 30 days for cloud based access as well as local
server set up. User can set up host server into his local machine as well by following
installation guidelines and fulfiling pre-requisite.

VersionOne Uses

There are a wide range of benefits and usage of VersionOne depending on team size, type of
work and other factors. The benefits and usage are listed below:

Y

VersionOne is used in tracking all QA activities from the 1st phase of software testing
lifecycle in Agile. Tracking can be started from adding the requirements to accepting
the requirement by the Product Owner.

VersionOne is useful in Project Management, Defect Management and to customize into
different agile methodologies as per the requirements. A user with proper role can
customize the VersionOne fields, boards, reports, displays according to project
requirement and standards.

In addition to the above, VersionOne also supports agile portfolio management, product
road mapping, regression test management, customer idea management, agile
visualizations and custom reporting and analytics.

It supports all macro level activities performed by QA.

VersionOne is very useful in performing QA tasks like planning, scheduling,
collaborating, tracking and reporting for projects, etc.
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VersionOne Specifications

The base of VersionOne is combined with different and latest technologies and ideas. To use a
developed VersionOne tool, hardware and software supports are required at Server as well as
Client side. Following table lists down important specification of VersionOne:

S.No. | Specification Description

e It is taken by VersionOne Inc.
e It provides Commercial and Trial

1 Application copyright )
Version.

e It can be used as Project Management
2 Tool scope and defect tracking.
e It is utilized as Agile Management Tool.

e Agile Testing

e Automation testing

3 Testing Methods e Exploratory Testing

e Functional/Manual Testing

e Complete life cycle of Agile
Methodologies
e Desktop Testing

4 Tool Objectives ]
e Web Testing
e Report statistics
e Product Backlog
e Resource Management
5 Management Features ¢ Defgct Management _
e Project Management in Agile
e Reporting
e CPU: Dual Core 2GHz and latest
6 Hardware Requirements for Server Memory : 4GB and aboveRAM
7 Error Handling e Capture screenshots
e Plugin
e GUI usability
8 User interface Available e Mobile UI

e Server and Web based
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2. VersionOne — Features

In this chapter, we will discuss the different features of VersionOne. The main feature of
VersionOne is to attract QAs and other stakeholders for Agile management.

VersionOne Core Features

VersionOne provides a wide range of features that prove beneficial to the Agile Project team.
It does not only support Project management but also how to do day to day activities in case
team is not situated locally. It provides a software solution to implement agile within the
globally situated team.

Following table lists down the core features of VersionOne:

S.No. g::t!ures Description
e VersionOne supports the following test methodologies:
e Agile Testing - Full Life Cycle Black box testing
1 Testing e Exploratory Testing
Supports e Functional/Manual Testing
e Automation Testing
e VersionOne toolcan create, centralize, organize and manage test
cases very effectively and efficiently.
e It caneasily import test cases from Excel and other management
2 Centrali_ze tool.
&organize | o It can create multiple versions of test cases for comparison and
uses.
e It can do planning of releases and sprints.
e It supports build out and re-run of test execution suites.
Manage & |° It kicks off automation suite as well.
3 Track e It captures step-by-step progress of sprint/release with detailed
Progress explanation.
e It supports day-to-day progress and individual contribution.
e Email can be sent for a particular task/communication to users.
e Voting and watching features to keep an eye on progress for
4 | Notification | ~ Stakeholders.
e Use @mention to get attention of specific team member at
Comments/Description.
e VersionOne supports powerful search functionality with Hotkeys
Power features.
5 Search e Supports free text search.
e Supports syntax search.
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e VersionOne supports multiple reporting.

e It supports Burndown, Velocity and Test Trends report.

e Generate detailed summary report for projects, release and
6 Reports sprints.

e Trackthe workload of entire team as well as individual.

e It supports Cross Project Report as well.

Scale with | ¢ VersionOne supports any business team and any project

7 | Team irrespective of size and complexity.
Growth

e VersionOne supports more than 80 pre-built integration to
connect with different software’s to make work easy.

e Wide range of add-ins makes it universal across the globe - JIRA,

8 Integration Bugzilla, ALM, GitHub, Borland, CA, Hudson, Jenkins, Visual
Studio etc.

e It also supports Salesforce, Microsoft, Zendesk.

e It supports sticky sidebars.
o Common o It supp0|'*ts I‘IC!’] ngt formathg.
Features e It helps in optimizing printing.
e It helps in scheduling and forecasting.

e It helps in generating and downloading full system backups.

0 Recover e Migrate and import existing test cases from Excel and legacy data
Data tool.

e Export data into CSV, XML and Excel files.
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3. VersionOne — Free Trial Access

VersionOne provides free trial for 30 days to registered users. The free trial version of
VersionOne comes with basic features. TestRail has other plans as well with different advanced
features and add-ins. The cost depends on the products that come along.

VersionOne has the following different products:

e Team
e Ultimate
e Catalyst

e Enterprise

VersionOne Team is free for Single Team with basic features for other products VersionOne
provides 30days trial period.

By visiting https://www.versionone.comy/product/lifecycle/pricing-and-editions/ a user can see
the different available plans for trying purpose.

] m

— C | @ Secure | https//www.versionone.com, t/lifecy edit 1«
—————
Y VERSIONONE PRODUCTS  CUSTOMER SUCCESS PARTNERS RESOURCES  ABOUTUS | TRY FREE Q
N ——
VersionOne Lifecycle for Agile ALM
Product Editions
Select the right-sized edition to fit your needs
Team Catalyst Enterprise Ultimate Vs
Single Team Cross-Functional Multiple Teams Organizations Unifying Enterprise
Starting with Agile Team Ramping Agile Expanding Agile Scaling Agile Agile & DevOps
P— —_—
GET IT FREE ( TRY FREE

« Story, Defect, and Test

Tracking

« Release and Sprint Planning

« Storyboard, Taskboard &

Testboard

=
| TRY FREE
Request Pricing

Includes Team Edition features

plus:

* Muli-Project Support
+ Scrum & Kanban

« Sprint Review &

Pe acthio

Includes Catalyst Edition

features plus:

« Portfolio Epic Management

+ Program-level Planning

« Advanced Reporting

n £9

TRY FREE J

quest Pricing

Includes Enterprise Edition

features plus:

+ Agile Portfolio Management
« Portfolio Level Kanban

* Product Roadmapping

laa ML

Request Prici

Includes Ultimate Edition

features plus:

* Release Workflow
Automation

* Value Stream Orchestration

Dok

)
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Setup for Free Trials

To use the free trial version, one time basic setup is required. It includes registering into
VersionOne by providing basic details and getting personal URL at email to access the
VersionOne.

In the following steps, we will learn how to set up the VersionOne while accessing it for the
first time:

e Visit https://www.versionone.com/ and click on Try Free at the top right as shown in
the following screenshot:

CollabNet and VersionOne Merge to Accelerate Innovation Across Enterprise Software Development and Delivery - Read More

FVERSION | PRODUCTS  CUSTOMERSUCCESS PARTNERS RESOURCES  ABOUTUS

It opens a basic form to create a VersionOne account.
e Enter the details at following fields as shown in the following screenshots:

o Name, Organization, Designation, Number and Country. These are basic details of
user and useful to set up profile after accessing the VersionOne. These details help
to maintain unique user concept. A user cannot enter duplicate records to register.

o Email: Please note, it accepts gmail, yahoo, outlook. It can be business email as
well.

Agie Software Free Trial - Versio. % | (R [T=rEE
€ a versionone.com we ¥ a9 =

Create Your Free
Account

SIMPLE TO SCALE ENTERPRISE

START YOUR FREE TRIAL

After entering all the details, check the checkbox for Term & Services and click on “Start Your
Free TRIAL".
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€ ) D& wioversionone.com/team-edition-setup htmi T8 3§ A O =
Next step: set up your profile and first project
5
You will use your emall address and this |
POSSWOrd 1o sign into your triol on subsequent
visits
E‘FE‘ ‘ ‘ Your Username:
m| ashishallissmile@gmail.com
s = 2 Create Password:
Drag-and-Drop P tive Story and Conversations
Taskboard
Easily plan and manage your Facilitate collaboration among
project backlog within a single Track and update progress team members with a bui
environment Consolidate, painlessly using VersionOne's interactive communication Confirm Password:
priaritize and rank stories and whiteboard style, interactive platform. Conversations lets
defects within projects via Storyboard, Taskboard, and participants send messages.
simple drag-and-drop and Testboard. Customize cards with follow each other, contribute to Project Name:
multi-select actions at-a-glance visual cues for the project-related discussions and
metrics most important to you. connect over general topics of My New Project
interest
Sprint/iteration Name:
=

VersionOne

It will display the next page

name. Now, click on Set Up.

where a user should create password and provide Project/Sprint

€ ) O F mioversionone.com team-edition-setup htmi

Drag-and-Drop Planning

Easily plan and manage your
project backlog within a single
environment. Consolidate,
prioritize and rank stories and
defects within projects via
simple drag-and-drop and
multi-select actions.

gjo|o
0

Interactive Story and
Taskboard

Track and update progress
painlessly using VersionOne's
whiteboard style, interactive
Storyboard, Taskboard, and
Testboard. Customize cards with
at-a-glance visual cues for the
metrics most important to you

(44

Conversations

Faciltate collaboration among
team members with a built-in,
interactive communication
platiorm. Conversations lets
participants send messages,
follow each other, contribute to
project-related discussions and
connect over general topics of
Interest

"VersionOne has enabled our teams to more effectively manage their

work and make progress transparent and visible to stakeholders."

— IT Professions/

Fortune 500 Retail Company

w8 ¥ AD

You will use your email address and this
password to sign into your trial on subsequent
visits.

Your Username:

ashishallissmile@gmail.com

Create Password:

ssssesee

Confirm Password:

Project Name:

My New Project

Sprint/iteration Name:

Sprint 1

Sprint/Iteration Length:

" Days E|
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Upon clicking Set Up, VersionOne creates the personal URL and account to access free trial
and send the email, provided into the form at the 1st page.

| Uimate Tl Set Up o L s N S s e e ) ¥ infouersionone.comvteam- %\ ||
€ ) @O F wioversionone.comteam-edition-setup bt B ¢ B8 $ A9 =
~ & AENET
{ - 678.268.3320 | Contact U
O VERSIONONE it

Get acquainted with VersionOne
while we finish your secure trial installation

Note: This may take anywhere from a few seconds to several minutes. You will also recelve an emall containing your trisl URL

Sign up for a live VersionOne demo:

Basics of VersionOne for Agile Agile Program & Portfolio Introduction to VersionOne’s
Project Management Management in VersionOne DevOps Solution
Wednesdays: 12:00pm EST Thursdays: 12:00pm EST Tuesdays: 12:00pm EST

REGISTER NOW! REGISTER NOW! REGISTER NOW!

An Email will look like as in the following screenshot:

/ M Trial Confirmation - ash X

&« C | & Secure | https//mail.google.com # 16032064 ®

Google - iE # 0@

Gmail ~ - a ]

- Q- More - 135067237 < | > -

‘Your VersionOne Trial is Ready! lng ver:

COMPOSE

I Inbox (6,551) YVERS[QNQN_E_

Starred

Important

Sent Mai Congratulations!
Drafts (4) Your Ultimate Trial Is Ready.

» Categories

More ~
Q;.S»‘,w + VersionOne is helping more than 50,000 teams scale
agile faster, easier and smarter. Experience it for
oty 2 ) Attend a Demo
yourseif and see why more than 93% of VersionOne
users said they would recommend it 10 a friend. See how VersionOne can
help you impeove your agile

hitps://www53.v1host.com/TCS08 ies

= Register Nowl
If you have any questions, just reply 1o this email and

we'll help you out. Thanks for trying VersionOnel

Agile Training

Best Regards B o tabiing catilog
The VersionOne Team 1o boost your organization's
agile initiatives.

5 View Training Catob

e By visiting the given URL, a user will get login page for VersionOne.
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4. VersionOne — Login

In this chapter, we will learn the steps involved to log into VersionOne.
Follow these steps to log into VersionOne.

Step 1: Tologin into VersionOne, go to your sample website, provided into email while creating
the free trial. It will open a login page.

Step 2: Enter your registered email address as Username and Password (selected while
creating the account).

Step 3: Click on the Login button.

Following screenshot shows how to login into VersionOne using credentials:

L 4
VERSION VIDEO TUTORIALS
—w
¢
Username

o o COMMUNITY SUPPORT

|

B Remember Me

Login
VERSIONONE PRODUCT BLOG

o\

Vi ne Lilecyck 1 Aglle
Ultimate Edition wi73.417

On Emor

While logging in, a user can face errors due to wrong combination of username/password. A
user can utilize different available features to reset password and login again. Here, we will
see what errors a user can face and how to find resolution to such instances:

e Due to unsuccessful login, a page as shown in the screenshot below might appear.

e Error may occurdue to wrong combination of email id or password.

Following screenshot shows the error message a user receives if the credentials are not correct:
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ww53.v1host.com/T

 VERSION_

oy

B Remember Me

VIDEO TUTORIALS

Login
COMMUNITY SUPPORT

Unable to log in. Please try again.

If this error continues, please contact your internal
VersionOne for (the person who provided =

SO S W A et . VERSIONONE PRODUCT BLOG
‘account status, '

To reset your password, please click the Forgot i
Password link above.

If you forgot the password, to recover it:
e Click on “Forget Password” beside the Login button.
e Enter the Login Email.

e Click on the Reset Password button. It asks to enter registered email to send the
password reset link.

The following screenshot shows how to recover the password if you forgot:

VIDEO TUTORIALS

Username
I

Login

a_o COMMUNITY SUPPORT

VERSIONONE PRODUCT BLOG

L on Aglle

VersionOne Lifecycl
Ultimate Edition vi73.417
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VersionOne

FVERSION

Please enter your VersionOne username OR the email
address on your VersionOne Account

Reset Password

A user will get an email with details to reset the password.

wwwi3.vlhost.com

FVERSION

Please enter your VersionOne username OR the email
address on your VersionOne Account

An email has been sent with a link to reset your password
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VersionOne

On Successful Login

In this section, we will discuss how VersionOne works on successful login.

On successfullogin, the My Subscription page gets displayed. The following screenshot displays
the welcome page of VersionOne on successful login:

/ B Subscriptions

C | @ Secure | httpsy//wwwi3.wlhest.com,T

Portfolio Product Release Team

RSS Feed
My Subscriptions
| A~
Title Description Notification Type L
Mo Results To Display
Notification Types
| W

@ = Title Descrption
@ Backlog Group

= Backlog tem

@ Defect

@ Issue

@ Package

@ Partfolio kem

@ Request

@ Task

@ Test

@ Test Set
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5. VersionOne — Dashboard

After logging into VersionOne, a user can navigate to Dashboard where progress of work is
summarized and a user can customize reports and matrices as well. A Dashboard is customized
by Admin. Based on roles, admin can set the access of VersionOne. Dashboard is similar to
homepage that displays all important details and provides links to access of other modules. In
this chapter, we will see features and customization of Dashboard.

Points to Note

By default, the Dashboard provides important details about project and the progress. It
displays the data for different modules like Project Hierarchy, number of Open Issues, Backlog
Count, Defects at project level in the hierarchy. In the following section, we will discuss the
important features of Dashboard:

e To navigate to the My Dashboard page, click on My Home -> My Dashboard link as
shown in the screenshot below. It displays the Dashboard page with the default set up.

@ +

Open Backlog Item Count Open Defect Count Open Issue Count %

» KX

i 0 0 0

e In the Dashboard page, My Project Summary is located at the top of the page. It shows
different metrics to evaluate the state of a project. Filters are also available to search
specific projects details. By default, the following fields display for each project:

o Project Title

o Owner

o End Date

o Projected End Date

o Progress Bars (hover to see Open and Closed Estimates)
o Open Stories/Backlog Items

o Open Defect Count

o Open Issue Count
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e The navigation bar, present at the top of the page, will be same across all pages/screen
of VersionOne - Project, Portfolio, Product, Release and Team. The navigation bar has
many sub links under each of these links. At the right side of the same navigation bar,
Report section is also available. By clicking on these links and sub links, a user can get
access to different modules/features supported by VersionOne.

e Dashboard has different links at the top right. These are same across all pages - Site
Navigator, Settings, User Profile and Help. These are the static feature of the
VersionOne HTML design.

e In the extreme left side, it displays few useful shortcut links as Add New Item for
Backlog Item, Defect, Story, etc., My Recent Changes to view all recent changes,
Rooms, Timesheet, Collaboration, Conversations, Topics and Deleted items. The
following screenshot displays the Dashboard of VersionOne:

C | @ Secure | https//wwwS53.vlhost.com

Portfolio Product Release

+ My Project Summary Print | | POF
()
= ﬂ .
:: 1iof1 A
E 2] .‘I'li\le t Owner End Date  Projected End Date Progress Open Backlog ltem Count Open Defect Count Open lIssue Count *
. 1 =4 System (All Projects) Ashish Anand 4 o 1] [}
= =] Sample: Company 4 o o o
=] Sample: Call Center Product 42012008 3227208 9 F 5 2
Sample: Release 1.0 1162018 22272018 gl 22 9 3
Sample: Release 2.0 ANB2ME . 2 3 1]

Add Chart

Dashboard can be customized by adding different available charts to track day to day progress
of the project/sprint. A user can add any of the following charts to the My Dashboard page.
These charts (displayed at the bottom of the page) help to track progress of the project,
sprint/iteration, and team status.

Project Burndown

e Sprint/Iteration Burndown
e Work item Trend

e Defect Priority Trend

e Velocity Trend

e TestTrend

e Work item cycle time

e Work item cumulative flow

To add a chart, click on the Add Chart button present at the My Dashboard page and select
one of the charts as shown in the screenshot below. It displays all available charts to add into
the dashboard.
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VersionOne

My Dashbosrd x W W N

int I PDF ‘
Lifecycle Proforences 8
7| -
Change Password
4 4 Vot p P Update yeur pessword by A Av |
= 2 Title * Qwner EndDate Projected End Date Progress Open Backlog ltem Count Open Defect Courl % ount %
Push Notifications
8 9 System (All Projects) Ashish Anand 1 0 o Manage novScations for thiee
B £ Sample: Company L o 4]
Agplications
Logout
x

[ My Dashboard x ‘- -
= C | @ Secure | httpsy//www53v1host.com/TCS08/ Default.as *
ek
B 4 System (All Projects) Ashish Anand 4 o o o
B 9 Sample: Company i o 0 1]
=E

Workitem Cumulative Flow | x
400 =

User Profie

A logged in user can view his profile in VersionOne. A user with admin role will have access to
all users’ profiles and can edit/update as well. In this section, we will discuss how to view
profile and update the details.

By clicking on the Profile icon, a user can view the following options:

e My Details - user can view his personal profile as shown below:

It opens the profile details with the edit button on the right side. A user can view History and
type of application by clicking on corresponding tab. In details, a user can see Project
Membership, Owned Projects, Link and Attachments as well.

The following screenshot displays the user detail page:

Edit the details on this page.
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[ My Dashiboard x___‘u Ashish Anand

C | & Secure | hitps//www53w1host.com/TCS

¥ Member

h Anand P Listory  Applications

=
Project Membership 5  Owmed Projects 1 Links 0 Attachments 0

SHORT NAME * PHOME EMAIL AVATAR LAST ACCESS

Ashish ashishalissmile@gmail com =5 ie200
USERNAME

Ashishanand
DESCRIPTION P
ADMIN PRIVILEGES * NOTIFICATIONS BY EMARL CREATED BY CHANGED BY
System Admin Ashish Anand

USES. A LICENSE - y
MANAGER CREATE DATE CHANGE DATE
VB0 100 AM 20T &43 PM

Once a user clicks on the Edit button, the user details open in a new window in the edit mode.
A user can change the details and click on Save to save the changes as shown below:

Jid VersionOne - Google Chrome i i

@ Secure | https//www53.vihost.com/TCS08/Defaultaspx?Page=W

Member

Avatar
Choose file | No file chosen | Remove
Please select a file that Is smaller than 2MB, and Is a .jpg/jpeg ot .png.
Image will be resized to 96x96 pixels
Short Name: Ashish 7

Usemame: AshishAnand

Password:

Admin Privileges: System Admin
Emall Address: ashishallissmilestgmall.com
Notifications by email

Phone Number

B 7 U S I. fomats B~ = I B B & » & B
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e Lifecycle Preferences: A user can select Navigation, Email forwarding options, Event
Notifications and Report Settings as shown in the screenshot below:

<« C | @ secur 1host.com/T fault A € wfeat ) 4 3

Lifecycle Preferences

Uight

e Change Password: Using this option, user can change the current password and set
a new one.

e Push Notifications: It manages notification from third party applications.
e Applications: It manages keys and tokens from third party applications.

e Logout: By clicking on Logout, a user will be get back to the login page and will not be
able to access project details without logging in back as shown in the screenshot below:

ttps//www53.v1host.com,

VIDEO TUTORIALS

Username

» COMMUNITY SUPPORT

B Remember Me

Login
VERSIONONE PRODUCT BLOG

Ultimate Edition vi73417
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6. VersionOne — Invite Users

VersionOne supports the invitation functionality. A logged in user can invite any number of
users to join VersionOne. A user with Admin role can directly add the user into VersionOne. In
this chapter, we will see steps about how to invite the user.

Follow these steps to invite new users into the VersionOne domain:

Navigate to the Setting icon present at top right of each page and select Members as
shown in the screenshot below. It opens the Member's page with the user’s details.

[ Members x — —— b =G
= C | @ Secure | https w53.vlhost.com, fault A ageifeat w H
hY% 0 20
< Projects Display Flelds Tags List Types Custom Felds Custom List Types Custom Columns t&F y
+ Projects Toams Configuration
Members ” : x
&
<
“ v Display Floids (] Membors DevOps
- T Create and Manage Membens
-n ncudng securty
e 140 of 10 Y v
bl Nome Username Short Name Adminpri [ [%9
&L Ashish Anand AshishAnand Ashish System Ac Edit v
= List Types
£ sample: Alfred Smith Sample: AS Project Le ‘ Edit v
Rl 2 Sample: Andre Agile Sample: AA Edit v
Custom Fiokds
@ 2 Sample: Bonnie BA Sample: BB Edit v
® 2 Sample: Boris Tester Sample: 8T Team Men Edit ~
Custom Ust Typos
L Sample: Claus Customer Sample: CC Team Men Edit v
&L Sample: Danny Developer Sample: DD Team Men Edit ~
Custom Columns
L Sample: Norman Newbie Sample: NN Project Le Edit v
& Sample: Tammy Coder Sample: TC Team Men Overviow Account Edit ~
R Sample: Vijay Vistor samplevijay Sample: W Visitor Edit +
px

Login as System Admin is a prerequisite to view this option.
The Members’ page that opens up displays a list of members having the domain access.

At the right side, a user can view the Invite Member button where a user can select
either Invite member or Add Member.

Invite Member: A user gets email to join the VersionOne.
Add Member: The Admin provides Username and Password to add one of the team

members who already has access to VersionOne for different domain. It is basically
allowing access of the project to a team member.

EIMPLYEAEYLEARMNING
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The following screenshot displays the Invite Member option:

"B Members
&« C | & Secure | https://www53.vLhost.com/TCS08/Defaultaspx?menu=MemberAdminPage&feat-nav=--a2 T
y My Home search Q CIE - 7 )

Projects Display Fields Tags List Types Custom Helds Custom List Types Custom Columns Teams Members Configuration DevOps Overview Account

+ Members Invite Members | «

(] o Invite Members
8 Add Member

s 110 of 10 ~
R Name Username Short Name Admin Privileges Phone Email =

The following screenshot displays the Invite Members form where the Admin enters email of
the invited member, the project to assign and the role to offer. After selecton, click on the
Invite Members button.

The user will receive the email to join the VersionOne along with a link.

/ I Members x §

- C | @ Secure | https//www53.vlhost.com/T

ashishanand64cryahoo.com

Assign Members to Project

Sample: Release 2.0

Admin Privileges
Project Lead
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Add Member

An Admin User can directly add a user or group of users into VersionOne and can set up
username and password on the user or the group’s behalf. It is useful when a team member
needs quick access to specific project.

Let us now see the steps to add a team member. The steps are as follows:
e To add a single user, click on the Add Member option. It will open a form wherein you

have to enter full name, short name, username, password, email address, notification,
admin privilege, description, etc. as shown in the screenshot below:

i VersionOne - Google Chrome b - o e ]
1

¥ Secure | hitpsy//wwwS3vlhost.com 8/Default.aspy Je 62 MWidget fPopups%2iQuickAddMemberd, o

Member D -
|| Mame Amit Singh ' N

Short Name Aumit

Usemame AshishAnand

Passwor

Admin Privileges Team Member ™| *

Emaill Address ashishanandbd@yahoo.com

Motifications by ema r

Phone Number:

B 7 Y 5 L fomas- B~ i E = & W
Description

e Now, clickon Save/Save & New/Save & View button to complete the add process.

o Save & New: It will add the user and open a new form to add another user.

o Save & View: It will add the user and open the details of the added user.
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7. VersionOne — Add A Project

In this chapter, we will see how to add a project in VersionOne.

Project is the backbone of a Project Management tool. Project represents a set of items and
tasks that should be completed in a defined time to consider it as completed. Until a project
finds its existence, none of other functionalities/tasks can be performed. Project groups all
sprints/backlogs/tasks/issues etc. into one place. In this chapter, we will discuss about adding
a project into VersionOne.

To add a project, a user should have the System Admin role.

Create a Project

Project helps to maintain hierarchy of all sub-items like backlog, defects and issues in order to
complete it in the defined time. These are useful to centralize multiple backlog as well as
relationship with project. In this section, we will discuss the steps performed to add a project
into VersionOne. The steps are as follows

e Login as Admin and Go to the Settings, present at right top,and select Project & Field
Admin -> Project as shown in below screenshot. It opens the Project page and displays
all available projects in the hierarchy. It will not display any project in case none of the
project is added before.

/ I My Dashioard x -_( Y —

C | & Secure | httpsy//www53.v1lhostcomT

Release

Portfolio Product

My Project Summary

v

Display Ficlds

Hof1 | A~
=B Tite * Owner EndDate  Projected End Date Progress T t -
{4 System (All Projects) Ashish Anand

List Types.
B 1 . \.

Sample: Company

Custom List Types

ure

400

Custom Columns

300
Crverviaw Accourt

e Expand the System (All Projects). Click on the Add Child Project button next to
the parent project under which user wants to create the new project as shown below:
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s Cusiom Flelds  Custom List Types

Ashish Anand 9222007
W27
Sample: Call Center Product w222017
Sample: Release 1.0 9202017

Sample: Release 2.0

1182018

Custom Columns Teams

Begin Date

Members  Configuration  DevOps  Overview  Account

of1

End Date Sprint Schedule =

A

47202018 Sample: Call Center Schedule

116/2018 Sample: Call Center Schedule

482018

Sample: Call Cener Schedule

Add Child Project
Add Child Project ]
‘Add Child Project | ~
Add Child Project ]

Add Child Project ]

It opens the add project form where a user needs to enter the details in the different

>t

fields:
Field Action Description
Titl Type the name of the project. | The name of the project/release as it
itie displays in the Project Tree.
This field is pre-populated | The name of the project that is one
Parent with the name of the parent | level higher in the Project Tree
Project project. Click on the name to | hierarchy.
view additional details.
. Click on the magnifying glass | The Iteration Schedule assigned to
Iteration ) . .
Schedul to assign an Iteration | the project.
chedule Schedule to the project.
Sele.ct %r:]ieorf ;Eizz following: Indicates how the specific node is
. p. being used in the Project. When this
Planning e Portfolio . - .
attribute is set on a Project, any new
Level e Value Stream : - . .
. child project will automatically be
e Release Train - .
assigned the next value from the list.
e Program Increment
Type a narrative description | This is a rich text field that allows to
Description | of the project. add expanded details about the
project.
Type in the budget amount. The allocated budget amount for the
Budget }
project/release.
Begin Date The date the project begins. The daFe the project begins. This field
is required.
End Date The date the project ends. The d_ate the project ends. This field
is optional.
Select the status of | Indicates the status of the project.
Status )
the project.
0 Type the first three characters | The person to contact if any
wner of the project owner's name. | questions.
tutorialspoint
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https://community.versionone.com/VersionOne-Lifecycle/Team_Planner/Sprint%2F%2FIteration_Planning/Scheduling_Work_in_Sprints%2F%2FIterations/Sprint%2F%2FIteration_Scheduling/Sprint%2F%2FIteration_Scheduling_Video
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VersionOne

Target Type in the Swag amount. The amount of Swag user expects to
9 be delivered in the project. Useful
Swag .
when planning.
Target Type in the Target Estimate | The amount of Estimate you expect to
Estimate amount. be delivered in the Project. Useful
Points when planning.

Test Suit Select a TestSuite from the | The TestSuite assigned to the project.
est suite dropdown list.

Pipelines Select a Pipeline from the | Pipelines assigned to the project.
dropdown list.
Type any additional project | Free form short text field for
Reference | information. information about the project.

¢ Now click on Save/Save & New/Save & View as shown the screenshot below:

i VersionOne - Goagle Chrome

& Secure | hitps:/uwwS3.vlhostcom

e

Sample-Version
System (All Projects)
@

Portfolio vl

-]
~
c
)
[
f
i
iiii
"
ik
|II\I
%
rl

1272672017

Ashish Anand x

e Afterclicking on Save, project gets listed as shown in the screenshot below.

&«
4 Tags ListTypes CustomFields CustomlistTypes CustomColumns Teams Members Configuraion DevOps  Overview  Account
O]
T
un Hoft A
E @0 Title * Qwner Begin Date End Date Sprint Schedule *
B £ System (All Projects) Ashish Anand 92202017 ‘Add Child Project | ~
Sample: Comparny 222017 Add Child Project
= | Sample-Version Ashish Anand 1272672017
8 Add Child Project
Move Project
@
Export MPX

There is Move, Edit, Close and Delete button as well to edit project details and delisted to the
project.
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8. VersionOne — Portfolio Planner

Portfolio Planning is used to focus on high level planning. It consolidates the Portfolio Planning,
Prioritizing, Tracking and Estimating functionalities. In this chapter, we will discuss about
Portfolio Tree, Roadmaps, Kanban board and Timeline. Portfolio Tree and Roadmaps are used
at Planning phase while Kanban Board and Timeline are used to track the progress.

Points to Note

In this section, we will discuss how to access Portfolio and the different sub-items.

e Portfolio consolidates portfolio planning, their tracking, prioritizing and estimating
functions.

e A user can access Portfolio planning by navigating Portfolio -> Planning.

e Similarly, tracking and planning rooms can be accessed as shown below:

/ [ My Dashbosrd

L

& C | 8 Secure | https//www53.v1host.com/T

Y

Portfolio Product Release Team Reports

Planning Tracking PlanningRooms (“primt | [(PoF

My Project Summary

u :
Roadmaps Project Timeline
@B Title * }acklog Item Count Open Defect Count Open Issue Count

Portfolio Treo Portfolio Kanban PlanningRooms

System (All Projects) Valse Stream Boaed 0 0
Budgets

Sample: Company

Sample-Version 0 0

Strategic Themes

e Portfolio Planning consists of Portfolio Tree, Roadmaps, Budgets and Strategic Themes.

e Portfolio Tracking consists of Kanban Board, Project Timeline and Value Stream Board.

Portfolio Tree

Portfolio Tree represents the Portfolio items into hierarchy - High level to Granular level. It is
like Parent-child tree where each Portfolio item is situated under parent item. In the
hierarchy/tree, the portfolio present at top is the highest level and decrease step by step for
the next item present under that. In this section, we will discuss how the portfolio tree works.

e The Portfolio Tree (formerly known as the Epic Tree) allows defining and evaluating the
functional hierarchy of features.

e A user can prioritize the features based on their relative value and high-level cost.
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e Whenever required, a user can decompose portfolio items into one to many
detailed levels of sub-portfolio items and backlog items that can be delivered by the
teams.

e While the team works at the backlog items, the Portfolio Tree tracks the progress of
the portfolio items. The following screenshot displays the Portfolio tree:

[ Portioho Tree

<« C | @ Secure | htt

AR T Q o %20

Portfolio Product Release

: —
7 n »
-n
- v 130f3 ‘\v
b4 Order & Title D Type Swag Esimate  progress Project Strategic Thomes “

D |a B8 Sample: Order Check | £-01001 2000 ;‘;‘,‘\’)’:‘ Coll Canter
(o) [ Soeapes Chack s B-01017 Enhancement 500 Sample: Release 10 Edit v
® 17 Sample: Credit Check | B-01043 New 500 Sample: Release 10 Edit v
@ 7 Sample: Legal Check 801044 New Feat 5.00 Sample: Release 1.0 Edit +

Sample: Call Center

. Add Child Portfolio Item ~
Prod

2 @ [ Sample: Warehouse Integration E-01002 5000

Sample: Call Center Sample: Key System

3 ) ampie: . pgration O
3 B8 Sample: Accounting Integration E-01003 10.00 Product Integration

Add Child Portfolio Item

e Toadd a new Portfolio hierarchy, user can click on Add Portfolio Item present at right
top.

e To add a portfolio item into existing hierarchy, click on the Add Child Portfolio Item on
the corresponding level, present at the right side of each portfolio as shown below. It
opens the Add Portfolio form where user provide details and click on Save.

<« C | 8 Secure | https//www53.v1host.com/T fault tf t w

‘ My Hame search Q O & 2 0

Portfolio Product Release

=
= S
-n
- v 130f3 A
b4 Order & g Title D Type Swag EStimate o o ioss Project Strategic Thomes “
- Pts.
7 Sample: Call Center
1 & [ Semple: Order Check £:01001 2000 Fadior Add Child Portfolio ltem | ~
roduct
(o) [ e G mns B01017 Enhancement 500 Sample: Release 10 Edit v
8 7 Sample: Credit Check B-01043 New Feature 5.00 Sample: Release 1.0 Edit +
B I3 Sample: Legal Check B-01044 New Foature 500 Sample: Release 1.0 Edit v
2 @ [ Sample: Warehouse Integration E-01002 50.00 Sample: Cul Center Senple: Key Systam Add Child Portfolio tem +
e N Sample: Call Center Sample: Key System .
3 ) 8 Sample: Accounting Integration E-01003 10.00 Product Integration Add Child Portfolio Item

Roadmaps

Roadmaps provide a flexible way to display important milestones to stakeholders. It is used to
set high level target in defined time. In this section, we will discuss the features of Roadmaps
and how it works.

e Roadmap is used to keep update the team about progress.
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e It keeps stakeholders in the loop so that they can understand current priorities and
timing and track how their needs will be fulfiled over time.

e It provides better feedback into the planning cycle with respect to how stakeholder
priorities the requirements.

e To accessthe Roadmaps, navigate to Portfolio -> Planning -> Roadmaps.

e It has 2 different layouts - Board and Timeline.

The following screenshot displays the Board Layout view:

&

C | @ Secure

hitpsy//www53v1host.comT

W My Home soarch Q U - B O

Projoct e Portfolio Product Release

Roadmaps  saveovew: oeraur + (I [woor]El= & meov ([EENIED
:i::.--ﬂ}

(Y v
T OCT - DEC JAN - MAR APR - JUN JUL - SEP
127312017 3E2018 63072018 9/30/2018

The following screenshot dispalys the Timeline layout with respect to the start date and the
end date:

ps//www53.v1host.com

Q

Portfolio Product Release Team Reports

Roadmaps  SAVEDVIEW. DEFAULT v m LAYOUT !",E & BIEC LA Publish | v
(Timekne )
& S

Center on Today'

Kanban Board

Kanban board is one of the important features designed to track the progress of any project.
In Agile methodology, a team can track even day to day activities and progress at backlog
items in the Kanban board. In this section, we will discuss the different features of Kanban
board:

e Kanban board is used to visualize, plan and track the progress of the portfolio items
and the child items.
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e It provides a board view with categorization as None, Define, Breakdown, Build, Test
and Deploy. Either of the backlog items/portfolio can be categorized among these based
on the progress.

e To accessit, navigate to Portfolio -> Tracking -> Kanban Board.

e By default, each card shows the ID, title, owner (if applicable), and the Swag (high
level size estimate). A user can have the basic details of the card by just viewing the

Kanban board. By clicking on the card title, they can view the details of the item.

e A user can drag and drop a portfolio item card to another place in the same column (to
prioritize the ranking) or move it to another column (to update the status).

e Click on the down arrow in the top right corner of a card for access to common the
actions as follows:

o Edit portfolio item details: It will allow to edit the details of the item.
o View portfolio item dashboards: It will open all the details in the view mode.

o Block portfolio items: It will block the portfolio item and ask the blocking reason.
Even a user can link it with blocking issues/defects/dependent story.

o Close portfolio items: It is used to close the item. Later, it can be re-opened if
required.

o Watch portfolio items: It is used to add the item in the watch list and get
notification if there is any change; the change can be with the status too.

The following screenshot displays the Kanban Board:

Portfolio Product Release

v

(None) | Define | Breakdown | Build | Test | Deploy
oo S v

Sample: 8] Edit Sample: Order Check Sample: Warehouse Integration

View Dashboard

Block

Watch Portfolio ltem
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Project Timeline

Project Timeline can be accessed as Portfolio - > Tracking - >Project Timeline. Project Timeline
can be used for the following:

e Plan and communicate current and future project delivery.
e View historical delivery of projects.
e To see the next level of detail, priorities, and progress from a single view.

e Understand the organizational velocity achieved in delivering previous projects that can
be used as a guide in planning future work.

e Project Timeline provides graphical view of projects. It displays the scheduling and
delivery of work initiatives, features, and sub-features for specific projects.

The following screenshot displays the Project Timeline’s view:

.+.

Project Timeline mn
&
<
un ﬂ b
-s
E Cernevm'TodaY’
5 2017 2018

Dec Jan Feb

2017 2018

Estimate =

EST csimote swog  Hide
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9. VersionOne — Product Planner

Product Planning is the actual start of the project. In this phase, Product Owner works with
backlog items to prioritize, groom and estimate.

In this chapter, we will discuss how to plan the backlog items and how to manage them in the
sprint level.

Points to Note

In this section, we will go through some important points that need to be considered in product

planning.

Y

Product Planning is the activity where Product Owners identify, organize and groom
the Backlog to prepare it. The development/testing/BA team(s) works on this aspect.
If planning does not happen properly, sprint works affect the productivity and timeline
of project.

It involves managing the backlog items, test sets and defects that define the updates
going into the product.

These items form the backlog and are ranked by priority so they can be scheduled
into releases/projects and sprints.

Product Planner is divided into two sections - Planning and Input. The Planning section
consists of:

o Backlog - It is used for planning and prioritization of Agile backlog in list view.

o Backlog Groups - It provides the hierarchical functional groupings used to segment
the backlog.

o Backlog Goals - It provides the measurable targets to drive the project effort into
a proper direction.

The input section consists of:

o Requests - These are generated by customers/stakeholders who approve the
assets/backlog.

o Issues - It captures roadblocks or dependencies or other issues that affect the
project directly or indirectly.

o Regression Tests — These are templates for Acceptance Tests.

o Templates - It is the standard template that is used to configure
stories/defects/backlog items.
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o Import - It is used to build the backlog by importing the data from excel sheet. The
following screenshot displays how to access the Product Planner items:

/ [ Baciog

¥ C | @ Secure | https//www53.v1host.com/T efault.aspiime: acklogPage Y

Ymuomvm Q AR -3 )

Project . e = Reports
System (Al Projects) Portfolio Product Release Team eport

Backlog Requests
u ) : i 26
S Xl (A~
Backlog Gi [ . —
Order t  Title ot ryio o e Priority  EstimatePts.  Project -
1 I Sample: Quick Status Check e Medum 500 Sample: Release 10 Edit v
Regression Tosts
A Backlog Goals ¥ for A = :
2 7 Sample: Enter RMA High 200 Sample: Release 10 Edit v
3 I Sample: Inventory Levels Off in Wat Tomplates Medium 100 Sample: Release 1.0 Edit v
4 [7 Sample: Add Shipping Notes High 5.00 Sample: Release 1.0 Edit v
Import
5 [ Sample: View Daily Call Count aring bom Exce Medum 500 Sample: Release 1.0 Edit v
6 I Sample: Hold Order 01022 Sample: Danny Developer Hgh 200 Sample: Release 10 Edit v
- -
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10.VersionOne — Backlog

Backlog is the list of all work items. Stories, Defects, Test sets are part of work items. Stories
are primary items in backlog. Work items categorize and define all works to be done for a
project and iteration/sprint level.

Access the Backlog Page

In this section, we will learn how to access the Backlog Page.

e Backlog page can be accessed by navigating the Product Planner -> Planning -> Backlog
as shown in the screenshot below. It opens the backlog page; the page consists of all
available backlog items.

/ I Bsciiog x| — ——— — | 2
€« C | & Secure | httpsy//wwwS53.vLhost.comT 1
W mreme s s Q LI

Portfolio = Product Release Team

i 5ocoo ros
[ Roquosts

L1}

s - b M A~

e Backlog Page provides a flexible, editable grid of workitems associated with a project
and all of its subprojects.

e Here, a user can add new workitems, as well as edit, filter, sort, categorize, and
prioritize existing items relative to one another.

e In the backlog page, a user can see the following fields for each workitem:

o Order: It shows priority of the workitems.

o Title: Name of each workitems.

o ID: It display unique id of workitems.

o Owner: The person who owns the workitem.

o Priority: It shows how prior the backlog item should consider.
o Estimate Pts: It provides the complexity of workitem.

o Project: It displays the associated project name.

The following screenshot displays the Backlog page view:
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www3.vlhost.com/T
Q
Portfolio Product Release
v 1250143 p M [
| Order +_ Title ) Owner Priority _ Estimate Pts. __ Project - |
1 [ Sample: Quick Status Check BO1017  Sample: Danny Developer Medium  5.00 Sample: Release 1.0 m
2 [*7 Sample: Enter RMA 8-01019 Sample: Tammy Coder High 200 Sample: Release 1.0 Edit ~
3 ™ Sample: Inventory Levels Off in Warehouse D-01001 Sample: Alfred Smith Medium 100 Sample: Release 1.0 Edit +
4 7 Sample: Add Shipping Notes B-01020 Sample: Andre Agile High 5.00 Sample: Release 1.0 Edit ~
5 [*7 Sample: View Dally Call Count B-01021 Sample: Alfred Smith Medium 5.00 Sample: Release 1.0 Edit v
6 7 Sample: Hold Ordet 801022  Sample: Danny Developer High 2.00 Sample: Release 1.0 Edit v
7 ™ Sample: Pick Lists Reversed D-01002  Sample: Andre Aglle Medium 2,00 Sample: Release 1.0 Edit +
8 7 Sample: Update RMA 801023 Sample: Danny Developer Medium 200 Sample: Release 1.0 Edit «
9 ™ Sample: Export Missing ID Column D-01003  Sample: Andre Aglle Medium 200 Sample: Release 1.0 Edit v
10 [ Sample: Multiple Ship-To's 801024  Sample: Danny Developer High 500 Sample: Release 1.0 m
1 2 Sample: Calculate Tax B-01025  Samole: Dannv Developer High 500 Sample: Release 10 Edit

Add Backlog ltem

A user with proper role canadd the Backlog Item into a project. Usually issues and defects can
be added by all users having access of project. Stories can be added by the product owner.
Now, we will discuss how to add a backlog item.

e Go to the Backlog page and click on the arrow sign of the Add Backlog Item Inline
button.

e It provides 2 different options to add each backlog item or defect.

e One option is Add Backlog/Defect Inline and the other is Add Backlog Item/Defect as
shown in the screenshot below:

[id Bociiog x § e
<« C | @ Secure | https//www53.v1host.com 8/Default " agetife *
VW (i) (e a onee0

Portfolio Release

+ Backlog
o
i U %
-n
s . 1250144 p Y
8 Order T Title [+ Owner Priority Estimate Pts. Project
1 [7 Sample: Quick Status Check B-01017  Sampie: Danny Developer Medum 500 Sample: Release 1.0

e When a user selects the Inline option, a new row gets added as 1st row. Here, the
mandatory details can be entered directly.

e After that, click on the Save button present at the right side to keep the record of
entered details as shown in the following screenshot:
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y [ Bocidog *

< C | & Secure

https,//wwwiivlhost.oom /TCS08/Defaultaspximenu=Frimary

Product

Portfolic Release Team

v
v 125 0f4d p Pl E (_cancel A~
2“’" Title D Oumer Priarity E::'“’“ Project “
| I3 [New hem . Ashish Anand Low M —] System (All Projects) ¥ |m

e When a user clicks on Add Backlog Item/Defect, a new window opens along with the
different fields to enter the details about workitem.

¢ Oncethe details are entered, a user clicks on the Save/Save & View/Save & New button.

The following screenshot displays the Add Backlog Itemy/Defect page:

)

ecure | https//www53.vlhost.com/T

Backlog Item Save  Save& New  Save & View

Title:
Project System (All Projects) ¥ *
Sprint v
Team:
Backlog
Group:

Portfolio hem: &

Description B 7 VY & I. Ffomas- BB~

" e

Backlog Goals

The Backlog Goal contains the group of stories or backlog items that provide the direction to
the Project Team. It is usually the standard target (short and long term) to measure the
direction of the project team. Consider the following important features of the backlog goal:

e A Backlog Goal contains group’s backlog workitems that display the progress of the
project team.

¢ It is measurable and specifies the direction and priorities of the project team.

e It can have many-to-many relationship with workitems.
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e It allows free association between stories, defects or even portfolio items to Backlog
goals.

e Toaccessthe Backlog Goals, navigate to Product Planner -> Planning -> Backlog Goals.

e To add a Backlog Goal, click on the Add Backlog Goal button present at the top right as
shown in the following screenshot:

Portfolio = Product Release
r Backlog Goals Planning Input
@ ﬂ . Backiog Roquosts
-n
H <
el T D Priority Project Dau . Noves Piea P
Regression Tests ay
(e} e and

Tomplates

® Import

e It opens a Backlog Goal form in nhew window.

e A user enters the details as Title, Project, Team, Planned Business Value, Actual
Business Value, Target in Project, Description, Type and Priority.

e After that, click on the Save/Save & View/Save & New button as shown in the
screenshot below. It saves the Backlog Goal. The goal can be viewed by a user at a
later stage of the project to compare standard Vs actual.

Vo oGt . g ey
& Secure | https//www53.vlhost.com, fault f t i f t f t=_hk
Bacioq God e B
Titl
System (All Projects) ¥ *

Target In Project (Check this box f you want to focus on th

(I
I

B 7 VU & I Fromas~

e There is an option Summary by Project. When user clicks on this button, a new
window opens and displays the progress of each project as % of Backlog Goal and
% of Project.
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The following screenshot displays the Summary by project:

[ Socidog Goass x

& C | @ Secure | https//www53.v1host.com 8/Default.aspx?menu alsPagefifeat-nav=--i %8 :

Q

Portfolio Product Release Team Reports

Backlog Goals

(7| 5
i 4 Vo1 p b Av

Title D Priority Project Targeted Estimate Pts % of Project Progress %
@ Improve Quality G-01005 Medium System (Al Projects) v 500 2%

- Google Chrome ‘I‘Q]"‘-'}
https://www33.vihost.com/TCSO Widgets/Containers/Oetails/Zoon )1:1545&RefreshGadget
44 Hoft p ) [ v
. ., Estimate Pts, - so. % of Backlog % of Unestimated Backlog -
© B Thie Targeted poliup Progress Goal Project  lkems y
& [ System (All Projects) v 5.00 Ll 100% 2% 0
B [ Sample: Company Y 5.00 il 100% % o
- , Sample: Call Center -
=] Product v 5.00 J 100% 2% 0
£5 Sample: Release 1.0 v 5.00 8 00% % 0
£8 Sample: Release 20 ¥ 4 0% 0% 0
4 Sample-Version V. 4 0% 0% 0
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11.VersionOne — Story

Story represents requirement, additional or change in existing functionality or new features.
Stories are units of business values those can be estimated, tested and completed within a
defined sprint.

Stories consist of mainly two aspects:

e Acceptance criteria of the functionality to define acceptance tests.

e All the tasks are required to be completed by the team to deliver the story.

Add a Story

In this section, we will learn how to add a story. Story can be added by the Product Owner.
Usually a team member cannot add a story until he has special roles like that of an admin,
product owner, team lead, etc. There are many ways to add a story. We will discuss the ways
as options below.

After addition, a symbol in green color shows up. The symbol represents a Story.

Option1
e Go to the Product Planner -> Backlog.
e Click on the Add Backlog Item Inline button present at the top right.

e It will quickly add a top row where a user needs to enter the detail and click on the
Save button. It adds the story into backlog items as top row.

The following screenshot displays how to add a story inline:

o e m —— _
<« C | 8 Secure | httpsy//www53.v1lhost.com/T fault.aspxime Prim scklogPagesfeat-na: d .
Vb v Q EEEE

= Product

Portfolio Team

‘ £
-_ Add Backlog Item Inline |
o)

~ 1250f 45 b M B concel |[ A~
H Qe Title D Owner Priority Faumate  project “

il System [All Projects) ™ | Iml
(97 1 [ Sample: Quick Statis Check B-01017  Sample: Danny Developer Medium 5.00 Sample: Release 1.0 Edit ~
@ 2 7 Sample: Enter RMA B-01019  Sample: Tammy Coder High 200 Sample: Release 1.0 Edit ~

Option 2

e Go to Product Planner ->Backlog.

e Click on arrow symbol of Add Backlog Item Inline button present at top right.
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e Click on Add Backlog Item option.
e A new window opens along with different fields to enter details about story.

e Oncethe details are entered, a user clicks on the Save/Save & View/Save & New button.
It adds the story into the backlog items and appears based on applied sorting methods.

The following screenshot displays how to add a story detail:

7 Bockion - T — s s F=rGY
& C | @ Secure | https//wwwS53.v1host.com/T efault.aspx?me Pnma ack Page&feat-na 2 44
‘ My Home search Q O & Q2 O

Portfolio Product

Release

Projoct
System (All Projects)

Backlog
/b\
g & %
L L)
L v { 4 125045 p M}
24 Order T Title 3] Owner Priority  Estimate Pts. Project

The following screenshot displays the Story Details page:
/ [ Bocdon "\B v- —— — — o | B

& C | @ Secure | https//www53.v1host.com/T ofault.aspxme PrimaryBacklogPage&feat-na ﬁ,

Backlog Item Save  Save&New  Save & View [NeUIHI
Title: ————
Project | System (All Projects) ¥| *
Speint v
Team
Backlog

Group:
Portfolio tem; &

Dechiol g 7 U S T.| Fomas~ | @
L . A |

Option3
e C(Click on the + icon at the sidebar menu. It opens the Add New options.

e Click on the Backlog Item option as shown in the following screenshot:
T oo A - e ~ =5

<« C | @ Secure | https//www53.vlhost.com/T efault.aspxn PrimaryBacklogPage&feat-na °4

Q

System (Al Projects) Portfolio Product Release Team Reports

Add New
£33 Backlog ltem

4 1250045 p B (A~)

10 Owner Priority  Estimate Pts. Project %
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¢ A new window opens along with the different fields to enter the details about the story.

e Once the details are entered, a user clicks on the Save/Save & View/Save & New button
to add the story into the backlog item.

Access Story Details

After the addition of story, details can be accessed by any team member having the project
access. In this section, we will discuss how to view all the details of the story.

e To view the story details, click on Title or ID anywhere it appears in VersionOne. It
opens the story details in a new pop up window.

e Conversations and Activity Stream are present at the left side of the page.
e At the top right, the Action Menu is present.
e Relationship Links are present at the top bar.

e The main page consists of the story details.

The following screenshot shows the Story Details page:

Sample: Quick Status Check

Backlog Goals 1 Uinks O  Attachments O
Ll

PROJECT * BACKLOG GROUP
Sampio: Reease 10 Samplo: Order Managymght
SPRINT PORTFOLIO ITEM

Sampia: Moath C st Half Sampio: CRBEIEREERIP links

story detalls

Sample: Andre Aglle
TEAM

Sampio: Toam A

OWNERS
Subscribers: Sample: Claus Customer Sampio: Danny Developer
Sample: Now that we have this Order Check
Epic, | would like your input on the different STATUS PRIORITY TASK STATUS SUMMARY
“pleces” you'd like for this Epic Futuee Modium
. . TEST STATUS SUMMARY
- 5 - DATE COMPLETED CLASS OF SERVICE . 530

7 Sampic: Credit C [ Sampie: Legal C.
[ Samplo: Order C.. [ Sampie-Grderst . TAGS
ESTIMATE PTS. COMPLEXITY

[7 Samplo: Quick St High

S00

CODE COMP1 ITY RANK (0-300)
DELIVERY CATEGORY i N ’
1 2 Earlier Replies

‘ Sampile: Claus Customer

DESCRPTION

< s s we

Sample: Looks good. As long as wi As 3 Wolosalos roprosontative, | can chack the status of an existing order using customeor and/or order Information provided by the

have a way to check the order status | customer o that wo can confirm the contonts of the order and apprise tho customer of the expectod <hip o delivery date.

am good. The abllity for the customer
i ative to get this done in the PRODUCT OWNER TYPE PLANNED ESTIMATE PTS

mount of time will be
important so | will rank Quick Status
check soon after Order Status Check. EEFDEN SOURCE

Sampie: Claus Customer Enhancement
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From the Story Details page, the following high-level tasks can be performed using the tabs at
the top right of the grid:

If a user wants to... Do this...
View or update story details Click the Details tab.
View the change history for a story Click the History tab.

View a graphical representation of the | Click the Visualize tab
story's relationships to other workitms

Edit story details Click on the dropdown to select the Edit tab
and later open the Story Edit window. A
user can also open this dropdown menu to
perform other actions (Plan Story, Add
Task, Add Test, Generate Parent Epic, Copy,
Sign Me Up, Block, Split, Quick Close, Close
and Convert to Defect, Delete, and Watch
Story).

Following screenshot shows the tab of high level tasks:

[ Baciiog x W — el s |

| -

< C | @ Secure | https//www53.v1host.com/T efault.aspx?menu=Prir acklogPagetifest-na %

¥ Backlog Item B-01017

Conversations

n

PROJECT *
Sampie: Redease 10
SPRINT
Sampio: Month C 15t Halt
Sampile: Andre Agile
oy Sampio: Danny Developor
STATUS PRIORITY TASK STATUS SUMMARY
“pleces” you'd like for this Epic Futuee Modium
- TEST STATUS SUMMARY
Ms Co c_ M~ " o DATE COMPLETED CLASS OF SERVICE
7y Sampic: Crodit C 7 Sampio: Legal C.
! Samplo: Order C... [ SompiesGrderst - TAGS
ESTIMATE PTS. COMPLEXITY
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Manage Story Details

At the bottom of the Story Details page, a user can perform the following functions by clicking
the Add or Assign buttons. To remove any items, a user can click Remove from the selected
story.

If user wants to... Do this...

Add a new task Go to Tasks and click Add Inline.

Add a new test Go to Tests and click Add Inline.

Assign upstream dependencies from | Go to Upstream Dependencies and
available backlog clickAssign.

Assigh downstream Go to Downstream Dependencies and

dependencies from available backlog click Assign.

Identify (select) issue(s) that have | Go to Issues Resolved and click Assign.
been resolved

Select an existing issue to assign asa | Go to Blocking Issues and click Assign.
blocking issue

Select existing backlog items that are | Go to Breaks Workitems and clickAssign.
affected by the defect

Select an existing request Go to Requests and click Assign.

Select an existing defect that breaks | Go to Broken By Defects and clickAssign.
the selected story

Designate the most current build(s) | Go to Last Affected Build Runs and
affected by the defect clickAssign.

Add a new link to remote | Go to Links and click Add.
documentation

Add a new file attachment Go to Attachments and click Add.
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The following screenshot displays how to manage story details:

em B-01017

Q, Sample: Quick Status Check

Tasks

Tests

Upstream Dependencies

Downstream Dependencies

Issues Resolved

Blocking Issues

Requests

Broken By Defects

Summary

Backlog Goals 1

T e e — =

C | @ Secure | httpsy//www53.vLhost.comyTCSOB/story.mye,

Links O
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12.VersionOne — Edit Story

In this chapter, we will learn how to edit story in VersionOne. Editing a story consists of many
actions. With the Edit Story feature, we can modify the details of the story, close it, delete it,
add it into the watchlist, block it with issues or defects, convert into defect, etc. In this chapter,
we will discuss how to go about editing story details, closing a story and deleting a story.

Edit Story Details

While editing the story details, a user can edit the details of the story including title, priority,
estimation and dependencies. The only field that remains unmodified is the unique id of the
story; it can never be changed or modified.

There are three ways to edit a story. The ways are described as options below:

Option1

It is recommended to quickly edit title, story points, projects, priority, owner and order. Follow
these steps in Option 1 for editing a story.

e Go to the Product Planner -> Backlog. It opens the backlog page.

e Double-click on row to make the column editable. The column changes from view only
to edit mode.

e After editing, click on the Save button. It saves all the modified details of the
corresponding row.

The following screenshot displays how to edit by taking up Option 1:

/ I Bacidog endie IR —S——— iR
€ C | & Secure | https//wwwS3vlhost.com/T fault.aspxime Prim 2cklogPagesifeat-na J #r 1
W My Home soarch Q U

Portfolio = Product Team Reports

+

(G -

-m

HH . 125 of 45 p Pl A

g Order * Title o Owner Priority s:;"""‘“‘ Project -

o 1 7 | Sample: Quick Status Check * B0W017 | Sample: Danny Developer = Medium -||5.00 Sample: Release 10 | || Save

o] 7 a 7 | Sample: Enter RMA * B-01019 | Sample: Tammy Coder x High | |2.00 Sample: Release 10 | *

@ 3 = | Sample: Imventory Levels Off in Warehouse |* D201001 Sample: Alfred Smith Medium 1.00 Sample: Release 1.0 Edit
Option 2

Follow these steps under Option 2 for editing a story.

e Go to Product Planner -> Backlog.
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e Click on the Edit button present corresponding to each row. It will open the story details

in the Edit mode.

e After editing, click on Save/Save & View. It saves all modified details of the
corresponding story.

My Home v

C | & Secure | https//wwwS53.vlhost.com/T

Q

Project

Portfolio

Product

Release Team

4 € 1250145 p )}

Order * Title ] Owmer Priority Estimate Pts. Project “

§ 1 I3 Sample: Quick Status Check B-01017  Sample: Danny Developer Medium  5.00 Sample: Release 1.0
2 "7 Sample: Enter RMA 8-01019 Sample: Tammy Coder High 200 Sample: Release 1.0 Edit
3 ™ Sample: Inventory Levels Off in Warehouse D-01001 Sample: Alfred Smith Medium 100 Sample: Release 1.0 Edit +
a4 7 Sample: Add Shipping Notes B8-01020  Sample: Andre Agile High 5.00 Sample: Release 1.0 Edit ~
5 [7 Sample: View Dally Call Count BO1021  Sample: Alfred Smith Medium 500 Sample: Release 10 [ Eait | - |
6 [7 Sampie: Hold Order 8-01022  Sample: Danny Developer High 2,00 Sample: Release 1.0 Edit v
7 ™ Sampie: Pick Lists Reversed D-01002 Sample: Andre Aglle Medium 200 Sample: Release 1.0 Edit +
8 [ Sampile: Update RMA 8-01023 Sample: Danny Developer Medium 200 Sample: Release 1.0 Edit -~
9 [ Sample: Export Missing ID Column D-01003  Sample: Andre Agile Medium  2.00 Sample: Release 1.0 Edit v
10 77 Sample: Multiple Ship-To's 801024 Sample: Danny Developer High 500 Sample: Release 1.0 Edit ~
il 2 Sample: Calculate Tax 801026 Samole: Danny D High 500 Samole: Release 10 Edit ~ |~

Add Backlog ftem Inline |

Reports

[ A~

The following screenshot displays how to access the edit functionality:

Option3

e Click on Story Title/ID to open the Story Details page.

e Clicking on the Pencil icon next to the field makes the field editable.

e Make the appropriate changes and then press Enter/Return on the keyboard. It saves
the modified details of the respective field.

The following screenshot shows the edit functionality at the story detail page:

klog Item B-01017
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Close a Story

Once all tasks of a story complete, it can be closed to claim the work done in the sprint. A
closed story can be re-opened later if required. In this section, we will discuss how to close a
story.

e Closing a story shows that all the work related to the story is complete.
e Once a story is closed, a user can re-open it if additional changes are required in future.
e Quick close updates the status of story and closes it in a single click.

There are many ways to close a story. We will discuss the ways as options below.
Option1

e Go to Product Planner -> Backlog.

¢ Click on the Edit dropdown present corresponding to each row.

e Select Close or Quick Close as shown in the screenshot below:

/I Beciiog x N 3 —— - — s Lol

C | & Secure | httpsy//www53v1host.com,T Defaultaspximenu=Prim acklogPageifeat-na 2 o

Backiog

~ 1250f44 p M | A~
Order T Title [} Owmer Priority  Estimate Pts.  Project -
1 [ Sample: Enter RMA B-00M9 Sampie: Tammy Coder High 2.00 Sample: Release 10 I:: E
Edit
2 [ Sample: Inventory Levels Off in Warehouse D-01001 Sample: Alfred Smith Medium 100 Sample: Relea
Plan Backlog ltem
k) ¥ Sample: Add Shipping Notes B-01W020  Sample: Andre Agile High 5.00 Sample: Releal  pdd Task
a I Sample: View Daily Call Count B-OW21  Sample: Alfred Smith Medium  5.00 Sample: Releg]  d Test
Generate Parent Portfolio ltem
L] [7 Sample: Hold Order B-01022  Sample: Danny Developer High 2.00 Sample: Releal Copy
[ [ Sample: Pick Lists Reversed D-01002  Sample: Andre Agile Medium  2.00 Sample: Relea  Sign Me Up
Block ¥
7 7 Sample: Update RMA B-01023 Sample: Danny Developer Medium  2.00 Sample: Releal 5
it
8 I Sample: Export Missing ID Column D-01003  Sample: Andre Agile Medium  2.00 Sample: Relea] | Quick Close

9 [7 Sample: Multiple Ship-To's B-0M024 Sample: Danny Developer High 5.00 Sample: Releail

Convert To Defect
10 [7 Sample: Calculate Tax B-01025  Sample: Danny Developer High 5.00 Somple: Reledl  patone
1 I3 Sample: Delete RMA B-01026 High 2.00 Sample: Relea]  Watch Backlog tem

e If a user selects Close, it opens an additional window. Here, select status and click on
the Close Backlog Item button as shown in the screenshot below:

B — . T — =
[ VersionOne - Google Chrome e=aaay

& Secure | https:/www33wvlhost.com 8/Default.aspa?Page=Widgets/Det nactivateStony B

Backl{}g ltem Close Backlog Hem Cancel |
1D B-01019
Title: Sample: Enter RMA
Total To Do Hrs 20.00
Future
" In Progress

Al Tasks and Tests will Oo values will be cleared

Accepted
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Option 2
e Click on Story Title/ID to open the Story Details page.
e Click on the Edit dropdown. It displays all the available options.

e Select Close or Quick Close as shown in the screenshot below:

= Edt
Tasks 5 Tests 4 Downstream Dependencies 1 Backlog Goals 1 Links O Attachments O
Pian Backlog Item

PROJECT STATUS PRIORITY tas{ Add Task
Sampio: Release 10 snagemont In Progress Hgh Add Test
SPRINT O ITEM DATE COMPLETED CLASS OF SERVICE TS,

Sampéo: Month C 15t Half Generate Parent Portfolio ltem

TEAM OWNERS ESTIMATE PTS COMPLEXITY Copy
Sampio: Toam A . - High
. Sampie: Tammy Coder 200 B Sign Me Up
e CODE COMPLEXITY RANX (0100}
DEUVERY CATEGORY
Block »
Split

ropresontative, | can create a Roturn Matorials Authorization (RMA) 106 & customer 50 that they can rotuen all of part of a shipped order for credit to thoir accoun)

TYPE PLANNED ESTIMATE PTS, SPUIT FROM 1 To Defect

us Customor Now Foatuso 200 Delete
SOURCE RETROSPECTIVE SPUIT FROM ID
Product Mgt Watch Backlog ltem

REFERENCE

suRD
REQUESTED BY

e If a user selects Close, it opens an additional window. Here, select a status and then
click on the Close Backlog item. Upon selecting the Quick close option, it directly closes
the story.

Delete a Story

A deleted story cannot be tracked and visualized later. Deletion usually happens if a story is
not needed or if it is duplicate. In this section, we will discuss the deletion of a story.

e If a story is created in error or duplicate, it should be deleted. For tracking the story, it
must be closed instead of deleted.

e Deleting a story hides all of its references.

e If a story is deleted, the child items like link, attachments, task or test sets also get
deleted.

Following are the steps to delete a story:

e Go to Product Planner -> Backlog.

e Click on the Edit dropdown present corresponding to eachrow. It displays the available
options to take action.
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Select Delete as shown in the screenshot below:
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It will open the read only detail of the story with Delete button. Click on the Delete
button as shown below. As soon as the button is clicked, the story gets de-listed from
the backlog item and all of its references will also be deleted.

[ VersionOne - Google Chrome = > i S e =————= )

8 Secure | https//www53.vlhost.com/T 8/Default.aspx?P

Backlog Item [ oeiete | [EER I

1D B-01019

Title: Sample: Enter RMA

Project Sample: Release 1.0

Sprint Sample: Month C st Half
Team Sample: Team A

Backlog Group Sample: Order Management

Portfolio tem

Similar steps as performed above can be followed to delete the story from the Story
Detail page.

Click on the Story title/id to open the story detail page.

Click on the Edit dropdown and select Delete.

It will open the read only detail of the story with the Delete button. Click on the Delete
button.
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A [ Baciicg

— C | @ Secure | https//wwwS53.v1host.com/T

¥ Backlog Item B-01019

Q, Sample: Enter RMA

PROJECT *

Sampio; Reloase 10
SPRINT

Sampio; Month C 52 Half
TEAM

Sample: Toam A

DESCRIPTION

Tasks 5

BACKLOG GROUP

Sampia: Order Managoment

PORTFOLIO ITEM

OWNERS

Sampio: Tammy Codor

Tests 4 Downstream Dependencies 1

BacklogGoals 1 Links O  Attachments O

STATUS PRIORITY
In Progross High

DATE COMPLETED CLASS OF SERVICE

ESTIMATE PTS. COMPLEXITY

200 High

CODE COMPLEXITY .
LA AT EGOR CODE COMPLEXITY RANX (0-100)

As 5 tol0sak0s ropresontative, | can create a Roturn Matorials Authorization (RMA) for 3 customer 50 that they can rotuen all of part of a shipped oeder for credlt 1o their accoun|

PRODUCT OWNER
Sampie: Claus Customor

REFERENCE

REQUESTED BY

TOTAL DETAIL ESTIMATE HRS.
4800

TOTAL TO DO HRS
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TYPE
Now Foaturo
SOURCE
Product Mgt
sunD

CREATED BY
Sample: Claus Customor

CREATE DATE

PLANNED ESTIMATE PTS, SPLIT FROM

200

RETROSPECTIVE SPLIT FROM ID

VersionOne

Edit

Plan Backlog tem
Add Task

Add Test
Generate Parent Portfolio item
Copy

Sign Me Up

Block

Split

Quick Close
Close

Convert To Defect

Watch Backlog ltem

CHANGED BY
Sample: Alfrod Smith

CHANGE DATE

48



13.VersionOne — Defects

In STLC, a user can create defectsto plan and track fixes. Defects are workitems of
the Backlog. Similar to stories/backlog items, a user can estimate points to defects that factor
into the team's velocity. A user can break it into tasks and acceptance tests to allocate the
work required to complete and deliver it.

Defects are flagged as red symbol to identify and differentiate from other backlog items.

Add a Defect

Defect can be added by all the team members having project access. There are many ways to
log a defect into VersionOne. In this chapter, we will discuss how to add a defect.

Optionl
e Go to Product Planner ->Backlog to open the backlog page.

e Click on Add Backlog Item Inline dropdown present at top right. It displays all available
options.

e Click on Add Defect Inline option.

e It will quickly add a top row where user needs to enter detail and click on Save button.

The following screenshot displays how to add a defect inline:

[ Bocdon
— C | @ Secure | https 3.v1lhost.com/T fault ack efifeat +4
‘ My Home search Q O & Q0 O

Portfolio = Release

+
& n ~

Add Backlog ltem Infine

Add Backlog ltem

- - +250f44 p M Add Defect Inline
b4 Order *  Title ) Owmer Priority  Estimate Pts. Project
1 [*7 Sample: Enter RMA B-01019  Sample: Tammy Coder High 200 Sample: Release 1.0
[ Baciieg ® | D
Lo C | @ Secure | hitpsy//www53.v1host.com,T fault.aspx?me Prim 2cklogPageSfeat-na J e
w My Home ~ soarch Q 2K - B 7 ]
Portfolic = Product Release Teamn Reports
+ Backlog Add Backiog ltem Inline | +
-m
s v 125 0f 44 b Bl m Cancel || A
" Qe Tite D Owmer Priority E:""‘"" Project -
5.
| [ [New Defect . - System (All Projects) ~ |
o 1 [ Sampie: Enter RMA B-01010  Sample: Tammy Coder High 2.00 Sample: Release 1.0 Ed!l £
@ 2 [ Sample: Inventory Levels Off in Warehouse D-01001 Sample: Alfred Smith Medium 100 Sample: Release 1.0 Edit ~
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Option 2
e Go to Product Planner ->Backlog
e Click on the Add Backlog Item Inline dropdown present at the top right.
e Click on the Add Defect option.
e A new window opens along with the different fields to enter details about the defect.

e Once the details are entered, a user clicks on the Save/Save & View/Save & New button.

The following screenshot displays how to add a defect:

/Il Bacieg

&

N

C | @ Secure | httpsy//wwwi3alhost.com,TCS08/Defaultaspximenu = PrimaryBacklogPageffeat-na

Product Release Team Reports

Projoct (Al Projects) Portfolio

Add Backlog Item Inline | ~
Add Backlog tem Inline
Add Backlog ltem

- 1+25cf44 p P Add Defect Inline

Order T Title o Owner Priority  Estimate Pts.  Project Add Defect

1 7 Sample: Enter RMA B-01019 Sample: Tammy Coder High 2.00 Sample: Release 1.0

ww3.v1lhost.com/T

Defect Save & View

Project System (All Projects) ¥ *
Speint v
Team:
Backlog
Group:

Portfolio tem: | &

Descipton: | g 7y g L. Fomais> BB (=
" P

Option3
e C(Click on the + icon at the sidebar menu. It opens the Add New options.

e Click on the Defect option as shown in the following screenshot:
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/Bl Bacideg x W —— . — =T
L C | @ Secure | https//wwwi3.vlhost.com/T DefaultascdmenusPrim scklogPagesifeat-na 2 s
Y wremes e Q RN

Projoct

System (All Projects) Portfolic Product Release Team Reports

s 2] Backlog ltem

125 of 44 p P [a~
o Owner Priority  Estimate Pts.  Project “
R t
eques " BOI019  Sample: Tammy Coder High 2.00 Sample: Release 10 [ Edit | - |

A new window opens along with the different fields to enter the details about the defect.

Once the details are entered, a user clicks on the Save/Save & View/Save & New button
to save the defect.

Access Defect Details

Once the defectis logged, a user can view the details. In this section, we will discuss how to
view the details of a defect.

To view the defect details, click on Title or ID anywhere it appears in VersionOne. It
opens the details of the defect in a pop-up window.

Conversations and Activity Stream are present at the left side of the page.
At the top right, the Action Menu is present.
The Relationship Links are present at the top bar.

The main page consists of the defect details.

The following screenshot shows the Defect Details page:

! [ Baciicg
< C

= Defect D-01001
2 ~
Sample: Inventory Levels Off in
% ‘ Wal'(:?h()lls(). History Visualize  Deliveny Edit ¥

Activities — , Actions’

@ Secure | https//www53.v1host.com/T fault enu=PrimaryBack e&feat-na *

Backlog Goals 1 Links O Aftachments O ‘

relationship links

TASK STATUS SUMMARY
DATE COMPLETED CLASS OF SERVICE TEST STATUS SUMMARY
TAGS

ESTIMATE PTS CODE COMPLEXITY RANK (0100}

100

DELIVERY CATEGORY :>Defect Details

DESCRPTION

The Customer D should always display the 1D of the main customer reford. The ID of the ship 10 is Boing displayed on order pages
and forms.

TYPE FOUND IN BUILD RESOLVED IN BUILD
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e From the Defect Details page, the following high-level tasks can be performed using

the tabs at the top right of the grid:

VersionOne

If user wants to...

Do this..

View all defect details

Click the Details tab.

View the change history for a story

Click the History tab.

View a graphical representation of the

story's relationships to other

workitems

Click the Visualize tab.

Edit defect details

Click the Dropdown arrow to select Edit tab
to open the Defect Edit window. User can
also open this dropdown menu to perform
many other actions (Add Task, Add Test,
Copy, Sign Me Up, Block, Split, Quick Close,
Close, Delete and Watch Defect).

Following screenshot shows the tab of high level tasks:

Sample: Inventory Levels Off in

Warehouse

DATE COMPLETED

ESTIMATE PTS
100

omer 1D should always display the 1D of the main custo
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m History Visualize Delivery Edit ¥

Backlog Goals 1 Links O Attachments O

CODE COMPLEXITY RANK (0-300)

mer record. The ID of the ship 10 15 Boing displayed on order pages

FOUND IN BUILD RESOLVED IN BUILD
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Manage Defect Details

At the bottom of the Defect Details page, a user can perform the following functions by clicking
the Add or Assign buttons. To remove any item, a user can click Remove from the selected
story.

If user wants to... Do this...

Add a new task Go to Tasks and click Add Inline.

Add a new test Go to Tests and click Add Inline.

Assign upstream dependencies from | Go to Upstream Dependencies and
available backlog clickAssign.

Assign downstream dependencies from | Go to Downstream Dependencies and
available backlog click Assign.

Identify (select) issue(s) that have been | Go to Issues Resolved and click Assign.
resolved

Select an existing issue to assign as a | Go to Blocking Issues and click Assign.
blocking issue

Select existing backlog items that are | Go to Breaks Workitems and clickAssign.
affected by the defect

Select an existing request Go to Requests and click Assign.

Select an existing defect that breaks the | Go to Broken By Defects and clickAssign.
selected story

Designate the most current build(s) | Go tolLast Affected Build Runs and
affected by the defect clickAssign.

Add a new link toremote documentation | Go to Links and click Add.

Add a new file attachment Go to Attachments and click Add.
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The following screenshot displays how to manage story details:

R Baciicg "VH D-01002 Sample: Pick L X —— il F=reT

C | @ Secure | https//www53.vlhost.com/T fect mmary?oidToken=Defect%3A108 %

= Defect D-01002

Sample: Pick Lists Reversed History Visualize Delivery Edit W

Links O Attach
Tasks e M |-

Tests

Upstream Dependencies

Backlog Goals
Breaks Workitems

Blocking Issues

[ Acdoto ]+

=)

Downstream Dependencies =3
=)

=3

=3

=

Broken By Defects
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14.VersionOne — Edit Defects

Editing a defect involves many actions. The different actions can be - modifying details of the
defect, closing it, deleting it, add into the watch list, block it with issues or another defects,
convert into story etc. In this chapter, we will discuss how to go about editing defect details,
closing a defect and deleting a defect.

Edit Defect Details

While editing the defect details, a user can edit all the details of the defect including title,
priority, estimation and dependencies. The only unmodified field is unique id of the defect, it
can never change or modify.

There are three ways to edit a defect. The ways will be discussed as options below:

Option1

The steps in this option are recommended to quickly edit the title, estimated points, projects,
priority, owner and order.

e Go to Product Planner -> Backlog. It opens the backlog page.

e Double-click on row to make the column editable. The column changes from the view
only to edit mode.

e Afterediting, click on Save. It saves all the modified details of the corresponding row.

The following screenshot displays how to edit the defect details:

/[l Bacdog x 1) —— . — e
L = C | @ Secure | https//www53.v1host.com/T faultaspeime Prim acklogPagedifeat-na b 1 1
> 1250144 b M B cancel |[a~ -
S— — — e ——— Pis —— -
1 ¥ Sample: Enter RMA B-01019 Sample: Tammy Coder High 200 Sample: Release 1.0 Edit
2 = Sample: Inventory Levels Off in Warehouse D000 Sample: Alfred Smith Medium 100 Sample; Release 1.0 Edit
3 ™ Sample: Add Shipping Notes B-01020 Sample: Andre Agile High 5.00 Sample: Release 1.0 Edit
4 5 Sample: View Daily Call Count B-01021 Sample: Alfred Smith Medium 5.00 Sample: Release 1.0 Edit
5 7 Sample: Hold Order B-01022 Sample: Danmy Developer High 2,00 Sample: Release 1.0 Edit
| b | @B T [sample: Pick Lists Reversed * D01002 | Sample: Andre Agile x Medum  ~|[200 | [Sample: Release 10 ~ | |m]|
7 7 Sample: Update RMA B-0W023 Sample: Danny Developer Medium 200 Sample: Release 1.0 Edit

Option 2
e Go to Product Planner -> Backlog
e Click on the Edit button present corresponding to each row of the defect.
e It will open the defect details in the Edit mode.

e Afterediting, click on Save/Save & View.
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The following screenshot displays how to access the edit functionality:

/ [ Backiog
& c

VersionOne

* N
Secure | hittps://www53.vlhost.com/TCS08/ Default Ba T y o

~ 125 0f 44 b P A T
[7 Sample: Enter RMA B-0119 Sample: Tammy Coder High 200 Sample: Release 1.0 Edit ~
__f Sample: Inventory Levels Off in Warehouse D-01001 Sample: Alfred Smith Medium  1.00 Sample: Release 1.0 Edit ~
'_', Sample: Add Shipping Motes B-01020  Sample: Andre Agile High 5.00 Sample: Release 1.0 Edit  ~
[ Sample: View Daily Call Count B01021  Sample: Alfred Smith Medium  5.00 Sample: Release 1.0 Edit ~
[7 Sample: Hold Order B-01022  Sample: Danny Developer High 200 Sample: Release 1.0 Edit ~
[ Sample: Pick Lists Reversed D-01002  Sample: Andre Agile Medium  2.00 Sample: Release 1.0 @
7 Sample: Update RMA B-01022  Sample: Danny Developer Medium 2,00 Sample: Release 1.0 Edit ~
™ Sample: Export Missing ID Column D-01002  Sample: Andre Agile Medium 2,00 Sample: Release 1.0 m

Option3

e Click on Story Title/ID to open the Story Details page.

e Click on the Pencil icon next to the field to enable editing. It makes the field editable.

e Make the appropriate changes and then press Enter/Return on the keyboard. It saves
the modified details of the respective field.

The following screenshot shows the edit functionality at the defect details page:

/ I Bacidog x ¢

&« C | @ Secure

PROJECT *
Sampio: Reloase 10
SPRINT
Sampio: Month C 152 Half
TEAM
Samplo: Toam B

DESCRPTION

https://www53.vlhost.com/T

BACKLOG GROUP

Samplo: Order Managoment

PORIFOLIO (TEM

Links O  Attachments O

STATUS

PRIORITY

Done Modum

DATE COMPLETED

E-01001 Sampio: Ordor

Check

OWNERS
Sampio: Andro Agio

ESTIMATE PTS.
200

DEUVERY CATEGORY

CLASS OF SERVICE

Tho Customer ID should always display the 1D of the main customer record. The 1D of the ship 10 is boing displayed on oeder Pages and forms.

TYPE
Codo

SOURCE

REFERENCE
Tost Run 4

ENVIRONMENT

Tosting

SPLIT FROM

FOUND IN BUILD

VERSION AFFECTED

FOUND BY

Johan K

TOTAL DETAIL ESTIMATE HRS.
800
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RESOLVED IN BUILD

VERIFIED BY

RESOLUTION

CREATED 8Y

Sample: Claus Customor

CHANGED BY

Sampie: Andro Agilo

History  Visualize

CODE COMPLEXITY RANK (0-100)

Delivery  Edit ¥

TASK STATUS SUMMARY
TEST STATUS SUMMARY

TAGS
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Close a Defect

Once all the tasks of a defect are completed, it can be closed to claim the work done in the
sprint. A closed defect can be re-opened later if required. In this section, we will discuss how
to close a defect.

e Closing a defect tells that all the work related to it is completed and that the fixes are
done.

e Once a defectis closed, a user can re-open it if the same bug appears again.
e Quick close update the status of defect and closes it in a single click.

There are many ways to close a defect. The ways will be discussed as options below.

Option1
e Go to Product Planner -> Backlog.
e Click on the Edit dropdown present corresponding to each row of the defect.

e Select Close or Quick Close as shown in the screenshot below:

Secure | https $3.vlhost.com/T

v 1250144 p M Edit
Title 1] Owner Priority  Estimate Pts.  Project Add Task
I3 Sample: Enter RMA B-01019  Sample: Tammy Coder High 2,00 Sample: Release 10| Add Test
Copy
[ Sample: Inventory Levels Off in Warehouse D-01001  Sample: Affred Smith Medium  1.00 Sample: Release 1.0
Sign Me Up
[*7 Sample: Add Shipping Notes B-01020  Sample: Andre Agile High 5.00 Sample: Release 10|  Block »
[*7 Sample: View Daily Call Count B-01021 Sample: Alfred Smith Medium 500 Sample: Release 1

I3 Sample: Hold Order 801022  Sample: Danny Developer High 2,00 Sample: Re
™ Sample: Pick Lists Reversed D-01002  Sample: Andre Agile Medium 2,00 Sample:

I3 Sample: Update RMA B-01023  Sample: Danny Developer Medium  2.00 Sample:

™ Sample: Export Missing ID Column I D-01003  Sample: Andre Agile Medium  2.00 Sample: Release

[*7 Sample: Multiple Ship-To's B-01024 Sampile: Danny Developer High 5.00 Sample: Release

If a user selects Close, it opens an additional window. Here, select a status and click on Close
Defect as shown below. If Quick Close is selected, it directly closes the defect without any
additional input.

[ VersionOne - Google Chrome Eg@‘ﬂ

@ Secure | https//www53.vlhost.com

1

=) -

D D-01003

Sample: Export Missing ID Column

Verified By

Total To Do Hrs 0.00
Done v
Future

In Progress

S I, Formas» EBv = = W B &

r

Accepted

@' tutorialspoint 57

EIMPLYEAEYLEARMNING



VersionOne

Option 2
e Click on the Defect Title/ID to open the Defect Details page.
e Click on the Edit dropdown.

e Select Close or Quick Close as shown in the screenshot below:

Edit
Links 0  Attachments O
Add Task
STATUS Add Test
Done Copy
DATE COMPLETED

Sign Me Up

0-100) Block »

ESTIMATE PTS
200 Split
Quick Close

nvert To Backlog tem

ot 1D should ahways display the 1D of the main customer record. The 1D of the ship 10 1s being displayod on order Pages and forms.

TYPE FOUND IN BUILD RESOLVED IN BUILD

e If a user selects Close, it opens an additional window. Here, select a status and click on
Close Defect.

Delete a Defect

A deleted defect cannot be tracked and visualized later. Deletion usually happens if a defectis
not needed or if it is duplicate. In this section, we will discuss the deletion of a defect.

e If a defect is created in error or duplicate, then only it should be deleted. For tracking
the defect, it must be closed instead of getting deleted.

e Deleting a defect hides all of its references.

e If a defect is deleted, all its child items such as link, attachments, task or test sets are
also deleted.

Let us now see the different steps involved to delete a story:
e Go to Product Planner -> Backlog

e Click on the Edit dropdown present corresponding to each row. It displays all the
available options to take action.
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Select Delete as shown in the screenshot below:

/I Bociicg x —— . —— o (B

& C | @ Secure | https//www53.v1host.com/T Default.aspx’menu=PrimaryBacklogPage&feat-na : *

v {4 1250144 p ) Edit |
Title 1] Owmer Priority ~ Estimate Pts.  Project Add Task
[7 Sample: Enter RMA B-01019  Sample: Tammy Coder High 200 Sample: Release 10|  Add Test
- Copy
Sample: Inventory Levels Off in Warehouse D-01001  Sample: Alfred Smith Medium 100 Sample: Release 1.0)
Sign Me Up
[7 Sample: Add Shipping Notes B-01020  Sample: Andre Agile High 5.00 Sample: Release 10|  Block N
I7 Sample: View Daily Call Count B-01021  Sample: Alfred Smith Medium  5.00 Sample: Release 10| P
Quick Close
[7 Sample: Hold Order B-01022  Sample: Danny Developer High 200 Sample: Release 10| 0.0
™ Sample: Pick Lists Reversed D-01002  Sample: Andre Agile Medium 2,00 Sample: Release 10| _Convert To Backiog ltem
Delete
[ Sample: Update RMA B-01023  Sample: Danny Developer Medium  2.00 Sample: Release 10|
_Wmch Defect
I ™ Sample: Export Missing ID Column I D-01003  Sample: Andre Agile Medium 200 Sample: Release 1.0 Edit | v
[7 Sample: Multipie Ship-To's B01024  Sample: Danny Developer High 5.00 Sample: Release 1.0 Edit v
7 Sample: Calculate Tax 801025  Sample: Danny Developer High 5.00 Sample: Release 1.0 Edit ~

It will open the read only detail of the defect with the Delete button. Click on the Delete
button as shown below:

[ VersionOne - Google Chrome. - T T o

@ Secure | https//www53.v1host.com/TC508/Default aspx?Page=Widgets/Details/Delete Defect Details&AssetContext= Defect: 108 28 RefreshGadget= o,
Defect Cancel |

1D: D-01002

Title: Sample: Export Missing 1D Column

Project: Sample: Release 1.0

Sprint: Sample: Month C st Half

Team: Sample; Team B

Backlog Group: Sample: Order Management

Portfolio Item: Sample: Order Check

The Customer ID should always display the 1D of the main customer record. The |D of the ship to ks being displayed on order pages

peserpten and forms.

Estimate Pis.: 2.00

Blocking Issues:

Tags

Owners Sample: Andre Agile

Status: Done

Priority: Medium

Type Code

Source:

Class of Service:

Reference Test Run 4 -

Similar steps can be followed to delete the defect from the Defect Detail page:

Click on Defect title/id to open the defect detail page.
Click on the Edit dropdown and select Delete.

It will open the read only detail of the defect with the Delete button. Click on the Delete
button to delete the record of defect.
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15.VersionOne — Release Planner

Release Planning is an optional activity. In this planning, the development team schedules the
work items to be delivered in a release, also called a project. As part of the effort, team
estimates and prioritizes the backlog items and then breaks them down into a series of
sprints/iterations.

In general, there are two types of release planning:

e Tactical release planning is done at the backlog level. It schedules individual backlog
items, defects or test sets for incorporation in a release.

e Strategic release planning is done at the feature level. It schedules the entire portfolio
items which automatically brings along the lower level backlog items. To drive strategic
plans, a team can use factors such as business value, risk, team velocity, and cost
(swag at the portfolio item level or Estimate at the backlog item level).

The Release Planner consists of Planning and Tracking activities. The planning activities group
Release scheduling, Regression Planning and Team Scheduling while the tracking activities
group Release Forecasting, Program Board and Delivery at a glance.

The Release Planner and its activities can be accessed by clicking on the Release Planner as
shown in the screenshot below:

Portfolio Product
+ View | Planning Tracking i
Ba('kk)g Add Backlog ftem Inline | v
o} Unscheduled Work Release Scheduling Reloaso Forocasting
TR System (All Projects) n
. 120f2 | v
Stats Teams Backlog Goals Assets Rogrossion Planning Program Board

b4 Title Priority Backlog “

4 e

ESTIMATE i g = R Delivery at a Glance S

oom 0o
a N Low Edit v
2

B Child Projects

Release scheduling is part of Release Planning. In this scheduling, release is scheduled for the
project. A project can have multiple releases and in this stage, all releases are scheduled like
when a release will go live and when all the release related works will be completed.

e The Lifecycle Release Scheduling feature is an optional release planning tool. It allows
to build a release plan by scheduling stories/backlog items or portfolio items into
releases.

e Release schedules an end date of release as well.
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e To access Release Scheduling, from the main menu, select Release Planner -> Release
Scheduling.

The following screenshot displays the Release Scheduling page:

/ [ Relesse Scheduling R
<« C | & Secure | https//wwwS53alhost.com/T 1
W wme v s Q CIE - ]
St (Al Projects) Portiolio Product Release Team Reponts
Miew: Swag | Estimate | A o Backlog for System (All Projects) Add Backlog Item Inline | ~
Unscheduled Work
7 -
System (All Projects)
- Hof1 | A
Stats. Teams Backlog Goals Assets —
Title 1] Swag Estimate Pis. Pricrity Backleg Goals b
SWAG COUNT UNSWAGGED % W/ SWAG
m Ponfolio Roms 0 0 7 abc B-01045 Edit ~
B -
ESTIMATE COUNT UNESTIMATED EETIMATE
= Backiog 1 1 0%
toms.
= Defects o ]
+ Tost Sets o o
Child Projects
Sample: Company
Stats. Teams Backlog Goals Assets
i |
4
v

e Theitems in the backlog grid on the left are "unscheduled". In other words, they have
not been added to a project/release.

e Note that once "scheduled", the work item is removed and no longer displays in the
backlog grid on the right.

B reasesesing < T R T > |
C | @ Secure | https//www53.v1host.com fault ¥ H
P p— ~-

System (All Projects) Portfolio Product Rolease Team Roports

ESTIMATE COUNT UNESTIMATED

e~ Backlog for System (All Projects) Add Backlog ltem Infine |

+of1 -\v

Title ] Swag Estimate Pts. Priority Backlog Goals %

7 abc 801045
Child Projects =5
Sample: Company
Stats = Teams Backlog Goals ~ Assets

Sample-Version
Stats = Teams Bacilog Goals  Assets

Nothing has been assigned to this Project level
Drag tems from the backlog to assign them here.

/W o [[AE % - e TIPTR

31-12-2017

e To add a backlog item into release, a user can drag and drop into Child Projects -
><Release Name> at the left side as shown in the screenshot below:
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Team Scheduling

Time Scheduling defines the timeline of the releases and completion as well as the start date
of other backlog items. Timeline is the standard reference to re-distribute work items and
resource allocation in the project.

e Team Scheduling allows the wuser to allocate and view workload across
assigned teams working on selected projects/releases.

e In Agile, backlog is assigned to the team, not to individual team members.

e Team Scheduling displays how workload is distributed across teams and the capability
to redistribute the work based on needs.

The following screenshot displays the Team Scheduling page:

[ Tesm Scheduling x U (Y Assignng 8 Sprint/iters X = JESNEC
“ C | @ Secure | hitps//www53.v1host.com t 1
A AR Q L3
Portfolio Product %) Release
+ Sprint:| Sample: Hardening Sprint v
(o]
All Teams m System (All Projects) | Total Open Estimate Pts. 326.00 / Scheduled Estimate Pts. 0.00 92272017 4 (None)
-n
bl Sample: Team A 120f2
o4 [ISample: Team A [ESample: Team B
8150 2650 1800 63.00
Backlog 7 m 5200
(©] 1100
@ 0.00
Bl Backiog Add Backiog Item Infine |
&4 >
124 0f 24 A
Title Backlog Group Priority Estimate Pts. Project “°
™ Sample: Connect Error to Warehouse Medium  2.00 Sample: Call Center Product m

™ Sample: Customer ID Incor Medium 200

Sample: Customer Management

™ Sample: Wrong Address on knvoice

Note: The Team Scheduling feature is being deprecated in favor of new Iteration/Sprint
Scheduling page.

Release Forecasting

Release Forecasting provides analyzed data based on the end dates. It also provides analyzed
velocity of the team to achieve targets at various ends dates. It is basically forecasting of the
entire project from high level to the granular level with respect to different target dates.
Following are a few important features of Release Forecasting:

e Release forecasting report simultaneously shows the forecasted end dates. This is
based on optimistic, pessimistic and average velocity.

e These velocity values are calculated from the visible historical data.

e It also indicates the end date of the selected project; with this, a user can compare the
forecasted dates to the planned end date.
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e In addition, a user can forecast the end dates based on total estimate or workitems
count.

e Release Forecasting can be accessed by navigating Release Planner -> Release
Forecasting.

e After the selection of report fields, click on Go. It displays the forecasting report.

The following screenshot displays Release Forecasting:

/ [l Release Forecasting x §

&« C | @ Secure | https//www53.v1host.com/T efault.aspx?menu=Releasef tingPage&feat-na Y

AR Q e e e

Project

System (All Projects) Portfolio Product Rolease Team Reports

I Release Forecasting
Start Date Interval  Interval Team Aggregation Type  Slice Remaining

80

o Optimistic 3/16/2018

60

40

Workitem Count

Date
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16.VersionOne — Sprint Planning

Sprint Planning is also known as Iteration Planning. In this planning, agile team identifies the
features to be worked on during a sprint. A planning meeting takes place at the beginning of
every sprint. The team discusses the highest remaining prioritized backlog items and breaks
them down into specific tasks and tests. Team also estimates the effort to complete them.
Velocity and the teams past performance are used to determine the amount of work the team
schedules into the sprint and commits to. Team members typically sign up for initial tasks
during the meeting and later pick up additional tasks if time permits during the sprint.

Sprint Planning is based on three pillars:

e Sprint Scheduling: In this phase, the team pulls the work that can be delivered from
prioritize backlog.

e Detail Planning: Workitem lists in the sprint with all the associated tasks and tests.

e Member Planning: Current sprint work rolled up per member; it is the average capacity
planning.

These can be accessed by navigating Team Planner -> (Under Sprint Planning) Sprint
Scheduling/Detail Planning/Member Planning as shown in the screenshot below:

[ Sprint Scheduling x WY — e S e
& C | @ Secure | https//www53.vlhost.com/T fault terat t b4
y My Home search Q LA - 2 2
Portfolio Product Release
it Team:| (Al v Sprint Tracking Review TeamRooms
1o} Sprint Schedufing Detall Tracking Close Sprint TeamRooms
i Sample: Call Center .. Backlog for Sample: |
T
Member Tracking
7 w Closed PLANNED COMPLETED > Datal Planning Retrospectives
Order . :
Sample: Month C 1st + Title
Half #25 9 16 Member Planning Storyboard
1772017 - 22017 {curreny S OMplO-Ouioh-Sk
i . S
Sample: Month C 2nd 7 Gheok
Half
Issues
2 T S Shepr e A Taskboard
Sample: Hardening
Sprint . 3 [ Sample: Enter RM
Sample: Inventory Tostboard
4 ™ Leve ff in v
Warehouse
o = Sample: Add Ship
2. ” Notes Ksves
. e Sample: View Dal
4 7 Count
w= Sample: Pick Lists Sample: R
7 o i 001002 Tomps Medum 200 Edit v _
Backlog Add Backlog ftem Inlfine |
sultaspx?menu=lterationSchedulingPage o~ -
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17.VersionOne - Sprint Scheduling

The first step in the Iteration/Sprint planning process Iteration/Sprint Scheduling. In this step,
the team selects the amount of work it can deliver from the prioritized backlog. The Team
makes use of the historical velocity as a guide reference to commit the work. This helps the
team determine how much to schedule in each sprint.

To access Sprint Scheduling, from the main menu, select Team Planner ->Sprint Scheduling.

Add a Sprint

It is the job of a Project Owner or Scrum Master to add a sprint. Sprint is added well before
the start date and it clearly mentions the start and end dates to achieve the committed goals.
Follow these steps to add a sprint into the project:

)

Navigate to the Sprint Scheduling. It opens the Sprint Scheduling page.

Select the Project in Project Navigator. It selects the project where sprint has to add.

After that, click on the Add Sprint button present at the left side as shown in the
screenshot below. It opens the Add Sprint form.

Portfolio Product Release

- 25 0 VELOCITY
Sample: Call Center ... Backlog for Sample: Month C 1st Half —o m's:l.

w Closad: - Sy | v 1909 A
Sample: Month C 1st | _Sample: Call Center Schedule Hitte D Portfollo  voum  Priority Estimate Dependency o, -
Half SPRINT LENGTTE ftem Pts. Status
WI7/2017 - W2N2017 (curreni . s Samp‘o e
[ Somple-Quicke SOl 5 5108 Order SImple:  Medium 3.00 Reopen Backlog ltem v
Sample: Month C 2nd e Check e
Half PROJECT COUNT
4 Sample: .,
801018 T High 500 Reopen Backlog ftem
Sample: Hardening — e
Sprint : N 3 801019 ?.f:;“’ﬂ High  2.00 - Plan Backlog ltem v
Sample:
4 D-01001 Medium 1.00 Edit v

TeamB

Enter the required and optional fields.
Required Fields - Title, Begin Date and End Date. The End Date should be a future date.
Optional Field - Description, Owner, Target Estimate Points, Change Comments.

After that, click on the Save button. It adds the new sprint into the project.
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The following screenshot shows how to add sprint:

[ Sprint Scheduling

< C | @ Secure | https//www53.vlhost.com/TCS08/ Default

Sprint

Title: Sprint 8
Begin Date: | [12/28/2017
End Date: | 110/2018
[ Description]

B 7 Y & L Fomasw EB- [ I
“ P W

Owner| | Ashish Anand x

Sprint]  sample: Call Center Schedule
| Schedule:

® A user can start adding items into sprint by dragging from the right and dropping at the
left.

View & Edit Sprint Details

From the Sprint Detail page, a user canview all the information associated with sprint and edit
the information if required. While editing the sprint details, a user can edit all the details of the
sprint including title, priority, date and description. Following are the important steps to view
& edit the details:

e To access the Sprint Detail page, navigate to Sprint Scheduling and hover over on the
Sprint Name at the left side.

e It displays the sprint name and the limited details into additional pop-up. Click on the
Sprint Name in the pop-up as shown in the screenshot below:

[ Serint Scheduling =

< C | @ Secure | hitpsy/www53.v1host.com/TCS08/Defaultaspx?menu =lterationSchedulingPagefifeat-navs--m: r H
‘y My Homa ~ soarch Q TN N
System (All Projects) Portfolio Product

+ Team: | (Al -
@ 25 0 veioary
| Sample: Call Center ... Backlog for Sample: Month C 1st Half —Me i'ﬁ‘f_-‘: Add Backlog ltem Infine | ~
H
. st cosa PLANNED COMRLETED ¥ TEolE | A~
i : . -

Sample: Month C Tst ?der Titte o Partfolic Team Priority Estimate Drnr?drncy -

I .25 9 16 Hhem Pts. Status
; Sampie z

) I 1 [P SmpierOudeSas g 0w Order SIMPIE:  Medium 3.00 Reopen Backlog ltem ~
(oY : [ F. 2] Check -
= 2 [7SampleShipOrder  BOWIB f.‘f:r"f"'é: High 500 Reopen Backlog ltem
: Sprif  END DATE 2 [ Sample: Enter RMA B-01019 3"”‘"‘:: High  2.00 - Plan Backlog ltem ~
O] - 12072017 : leam

Sprito 4 [ pample: AGISNPRN g 01020 Jomplel High 5,00 - Plan Backlog ltem ~

— 5 3 gi'l‘r?:e View Daily Call g 109 ?:;‘?'é Medium 5.00 Plan Backlog ltem

- -
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e It displays the Sprint Details page. It has different links like Backlog, Defect, Tasks,
Tests, Link and Attachment to view the respective details.

e The Following functionalities can be used in the details page:

If user wants to... Do this...

Access the Sprint Scorecard Click the Scorecard tab.

View the sprint change history Click the History tab.

Close the sprint Select Close from the Edit dropdown button.

Change the state of the sprint to Future | Select Future from the Edit dropdown button.

Delete the sprint Select Delete from the Edit dropdown button. If
the Delete button is not available, it means that
the sprint still contains items.

The following screenshot displays the different functionalities of the Sprint Detail Page:

/I Serint Scheduling % -\t (e

L | & Secure | hitps//wwwS53.v1host.com TCS08/ Default.aspx? menu=lterat edulingPageffeat-na " .

W Sprint

Sample: Month C 1st Half

Backlogltems 5 Defects 3 Tasks 168 Tests 4 Links 0 Attachments O

SPRINT SCHEDULE BEGIN DATE * ESTIMATE PTS. - ROLLUP
Sample: Call Conter Schadule WA2017 500

END DATE *
WIN 2017

STATE PROGRESS

Activo

COWNER
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18.VersionOne — Detail Planning

In this chapter, we will see how Detail Planning works in VersionOne. The Detail Planning page
helps display the list of all workitems in the current sprint. It also displays associated
tasks and acceptance tests. The page makes it useful to identify, assign and estimate the
activities those are required to complete the backlog scheduling in the sprint.

The Detail Planning Page can be accessed by navigating Team Planner -> Detail Planning as
shown in the screenshot below:

/ [ Detsil Planning

C | @ Secure | https

«
Y

Portfolio Product Release

Sprint Planr Sprint Tracking Review TeamRooms
Sprint:| Sample: Month C tst Half v | Team:| (Al > adiiiad ) R Y

Sprint Schedufing Detail Tracking Close Sprint TeamRooms
Sprint Summary s : ;
. . 0 Member Tracking Retrospectives
Last Closed S Mot B s 1162017 2700 Work .y o
Current Sample: Month C st Half 1W29/2017 25.00
T —
Member Planning Storydboard
Backlog Details
v tssuos
Taskboard
15
@ & Title 1] Owner Testboasd
@ [ Sample: Enter RMA B-01019  Sample: Tammy Coder
@ [77 Sample: Add Shipping Notes B-01020  Sample: Andre Agile ke
@ [7J Sample: View Dally Call Count B-01021 Sample: Alfred Smith
™ Sample: Pick Uists Reversed D-01002  Sample: Andre Agile Future 200 800 0.00 Edit v
[ Sample: Export Missing ID Column D-01003  Sample: Andre Agile Done 2,00 8.00 0.00 Edit v

e In the Sprint Summary section, a user can compare different values such as Total
Estimate Pts, Detail Estimate Hrs, Total Done Hrs, Total To Do Hrs of the current sprint's
contents with the last closed sprint.

e In the Backlog Details section, a user can define Detailed Estimate and track progress
directly at the backlog item or the defect level. A user can also create tasks or tests to
further breakdown work for the team. The overall status can be seen by viewing the
Status column of each item.
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The following screenshot displays the Detail Planning page:

'fa"'u Detail Planining = N_ Y

< C | & Secure | hittpsy/wwwS3.v1host.com/T
y My Home w seanch Q P 2 0
Portfolio Product telease Reports
+ Sprint:| Sample: Month C 1st Half  + | Team: | (Al A
Sprint Summary
Title End Date To De Total Done Hrs. Total To Do Hrs

174 Last Closed Sarrphe-Marth-B2aaHal MA62017 207.00 0.00
o

[Current: Sample: Menth C 15t Half 2002017 25.00 220,00 22000 noo

Baciog Detal

7 —

~ 14 4 15015 ) A |
w = B Title [[+] Owner Status Estimate Pts. Detail Estimate Hrs. ToDoHrs. =

@ [ Sample: Enter RMA BOWI0  Sample: Tammy Coder In Progress | 2.00 48.00 2000

@ [ Sample: Add Shipping Notes B-01020  Sample: Andre Agile In Progress 5.00 64.00 16.00 Plan Backlog ltem

@ [ Sample: View Daily Call Count B-01021 Sample: Alfred Smith Future 5.00 60.00 35.00 Plan Backlog tem  ~

[T Sample: Pick Lists Reversed D-01002  Sample: Andre Agile Future 2.00 800 Q.00 Edit 4

[ Sample: Export Missing ID Column D-01003  Sample: Andre Agile Done 200 800 0.00 Edit

- -
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19.VersionOne — Issues

In VersionOne, we can track impediments slowing down or blocking the progress ofworkitems
such as story, defect, portfolio item or test set with the use of the Issues Page. In many cases,
the impediments are small issues belonging to BA, Dev or test team; document or requireme nt
delays can also be considered as impediments. With a little bit of attention, most of the issues
can be quickly resolved and the impact minimized. If issues are unresolved, it canhave a huge
impact on the team and there is high risk of not completing the committed task.

Access the Issue Page

In this section, we will discuss the various ways to access the Issue page. An Issue Page can
be accessed by either of the following ways:

e Product Planner -><Input> -> Issues
e Team Planner -><Sprint Planning> -> Issues

e Team Planner -><Sprint Tracking> -> Issues

The following screenshot displays issues page:

Portfolio Product Release
ar Team: | (Al
&
sues =
-
1
(7| -
B
v 150f5 A
| Title o Owner Priority Target Date Project Team |
iy, Sample: No UPS Devices Left 01001 Sample: Tammy Coder High Sample: Call Center Product Edit ~
A&, Sample: Product Owner Retiring 01002 Sample: Andre Agile Medium Sample: Call Center Product Edit ~
iy Sample: No Hardware Yet 01003 Sample: Andre Agile High Sample: Release 1.0 Edit ~
i\, Sample: DBA Team Training 01004 Sample: Claus Customer High Sample: Release 1.0 Edit
b, Sample: QA Team Offsite 01005 Medium Sample: Release 1.0 Edit ~

e In this page, a user can view the summary of all issues like title, unique id, owner,
priority, target date, projects and Team as shown in the above screenshot.

Add an lssue

All team members having project access can add issue and link with impacted backlog items.
Issues can be logged not only related to backlog items but also process, delays in FSD or other
documents, resource allocation and any other issue that is affecting the team to achieve their
goal as a team. Issue also includes the Risk items. In this section, we will discuss how to add
an issue.

There are two ways to add issue:
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Navigate to the Issue page and click on the Add Issue button present at the top right
side as shown below:

[ fssues XQ_w — —— — I
= C | & Secure | httpsy/www53.¥1host.com faultaspximens eslterationPlan edfeat-nave--m *
MyHome ~ saarch = UK - 3 7
Portfolio Product Release
+ Team: | (All) v
[od
Issues Add Issue
-
]
(7| v
it S
~ 150f5 A |
Title o Owner Priority Target Date Project Team
» A, Sample: No UPS Devices Left =000 Sample: Tammy Coder High Sample: Call Center Product Edit «
@ b, Sample: Product Owner Retiring L0002 Sample: Andre Agile Medium Sample: Call Center Product Edit
E[ A, Sample: No Hardware Yet 1003 Sample: Andre Agile High Sample: Release 1.0 Edit «
A, Sample: DBA Team Training 01004 Sample: Claus Customer High Sample: Release 1.0 Edit «
A, Sample: QA Team Offsite 01005 Medium Sample; Release 1.0 Edit «

Or,

Go to the side menu bar and click on the + icon. Select Issues options from the Add
New field as shown below:

| PR x | 5
< C & re | https//www53.vlhost.com/T fault terat ifeat %
y My Home v search Q O &2 0

Release

Portfolio Product

e =
ﬂ Defect

Request 15015 v
0 Owner Priority Target Date Project Team
101001 Sample: Tammy Coder High Sample: Call Center Product Edit «
! Portfolio Item ng 101002  Sample: Andre Aglle Medium Sampie: Call Center Product Edit v
u] Backlog ltem From Template 101003 Sample: Andre Agile High Sample: Release 10 Edit ~
101004  Sample: Claus Customer High Sample: Release 1.0 Edit v
4 Defect From Template
101005 Medium Sample; Release 1.0 Edit v

@ Regression Test

A new window opens along with different fields to enter the details about issue.

Once the details are entered, a user clicks on Save/Save & View/Save & New button to
save the issue into the project.
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The following screenshot displays how to add an issue:

R 1ssues x 7‘ VersionOne * - — — e

C | @ Secure | hitpsy//www53.v1lhost.com/T Defaultaspx?page =Gadgets%2fAddMewhssatd2fOn wn%2fCont 2faddlssue +r 1
s T [ D
Title:
Project: System (All Projects) ™| *
Team:

B 7 U & L fomase - (= i 3 & -

Desaliption
Tag
Owner:
Type ~
Priority: -
Target Date -

View Issue Details

All team members can view the details of the different issues. All issues have unique id and
title. In this section we will discuss about issue details.

e To view the issue details, click on Title or ID anywhere it appears in VersionOne.

e Its unique ID starts with I and the yellow triangle that is an error symbol separates it
from the story and the defect.

¢ Conversations and Activity Stream are present at the left side of the page.

3vlhost.com/T

| Links 0  Attachments Dl

TEAM PRICRITY
Sampla: Reloase 1.0 High

i £B 1]
TYPE P Zmocms

Sampke; Andre Agio
TAGS

DESCRFTION

Wo dont have a production sorver
TARGET DATE REFERENCE

SOURCE

IDENTIFIEDEY CREATE DATE
W222017 T:M PM

RESOLUTION

CHANGED BY
Sample: C stomar
CHANGE DATE
WEHPOT T4 PM

FESOLUTION DETAILS
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e At the top right, the Action Menu is present.

e Relationship Links are present at the top bar.

e Afterthat, the main page consists of the issue details.

The following screenshot shows the Issue Details page

e From the Issue Details page, following tasks can be done using the tabs at the top right

of the grid:

If user wants to...

Do this...

View all issue details

Click the Details tab.

View the change history for a issue

Click the History tab.

View a graphical representation of the
issue's relationships to other workitems

Click the Visualize tab

Edit issue details

Click the Dropdown arrow to select the Edit tab
to open the Issue Edit window. A user can also
open this dropdown menu to perform many
other actions (Generate Backlog Item,
Generate Defect, Copy, Close Issue, Delete and
Watch Issue).

The following screenshot shows the tab of high level tasks:

ttps://www53.v1host.com
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Manage Issue Details

At the bottom of the Issue Details page, a user can perform the following functions by clicking
the Assign buttons. To remove any item, a user can click Remove from the selected field.

If user wants to... Do this...

Assign the issue to a backlog item such as | Go tothe Backlog Items Blocked by This
story, defects etc Issue and click Assign.

Assign a defect to plan and track bug fixing | Go to the Defects to Resolve This Issue and
work that was identified as a result of this | click Assign.
issue.

Assign a defect identified as blocked due to | Go to the Defects Blocked by This Issue and
this issue. click Assign.

Assign a test set identified as blocked due | Go to Test Sets Blocked by This Issue and

to this issue. click Assign.

Assign a request to this issue. Go to Requests and click Assign.
Assign a retrospective to this issue. Go to Retrospectives and click Assign.
Add a new link to remote documentation Go to Links and click Add.

Add a new file attachment Go to Attachments and click Add.

The following screenshot displays how to manage issue details:

T — E =
[ 101003 Sampie: No Har: X sl |e| D

C | & Secure | httpsy/www53v1host.com I 1 +r

A Issue 101003

Portfolio ltems Blocked by This Issue

Backlog Iltems to Resolve This Issue

Backlog Items Blocked by This Issue

Defects to Resolve This Issue

Defects Blocked by This Issue

Test Sets Blocked by This Issue

Requests

Retrospectives
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20.VersionOne — Task

In this chapter, we will discuss what a task in VersionOne is. Tasks are related to the estimation
in hours to achieve a backlog item. A backlog item can have any number of tasks to complete
the item. Itis a user’s responsibility to add all the tasks that need to be performed to complete
the backlog item. All tasks should be added on day 1 of the sprint. However, tasks can be
added and edited throughout the sprint if required.

Add Task

Task represents the work that is required to complete the backlog item. A user can add a task
into backlog items such as story, defect, and test sets, etc.

Follow these steps to add a task into backlog item:

e Go to the backlog items by clicking on title, summary or unique id from anywhere in
VersionOne.

e It opens the backlog details page.

e Now, clickon Edit -> Add Task at the right side.

e Click on Show Relationship down the page. Go to the Task section, click on Add Inline
or Add Task as shown in the screenshot below:

Sample: Enter RMA

Tasks 5 Tests 4 Downstream Dependencies 1 Backlog Goals 1 Links 0  Attachments 0

PROCUCT OWNER TYPE PLANNED ESTIMATE FTS. SPUIT FROM

Sampi: Claus Customer Mew Foature 200

R Add Test

REFERENCE SOURCE RETROSPECTIVE SPUIT FROM 1D
Product Mgt Generate Parent Portfolio lem

REQUESTED BY FuRn Copy

Sign Me Up

TOTAL DETAIL ESTIMATE HRS. CREATED BY CHANGED BY Block
s Sampie: Claus Custom vd Smith

Samgple: Al
Split
TOTAL TO DO HRS. CREATE
20,00 WIHIOW T4 PM Cuick Close
DONE HRS. Close
TOTAL DONE HRS. Corvent To Defect
3700
Delete

Watch Backiog ltem

=a

A

Status Detail Estimate Hrs. Done Hrs. To DoHrs.

e When a user selects Add Inline, it adds a row into task where a user enters Title, Owner,
Status, Detail Estimated Hrs. and To Do Hrs.
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After entering the details, click on the Save button as shown below:

VersionOne

<log Item B-01019

Sample: Enter RMA

Tasks 5 Tests 4 Downstream Dependencies 1 Backlog Goals 1 Links 0 Attachments O
VUL LUNE rses. .
3700
(15015 i o IR ES
Detail
Title D Owner Status Estimate 0o ToDo o
Hre Hrs.  Hrs.
& | QA-Execution Ashish Anand = [in Progress =] [12 Tl |
& Sample: Design Component TK0I062 Sample: Alfred Smith InProgress  8.00 1200 200 Edit ~
% Sample: Build Ul TK-O1063 Sample: Danny Developer InProgress  8.00 700 400 m

When a user selects Add Task, it opens a new window to add a task and ask to enter
details. It has some additional details like Build, Description, Tag, Type, Source and

References.

After entering the details, click on Save as shown in the screenshot below:

Task
Title:

Parent Backlog: Sample: Enter RMA

Owners:

Status:

Type:

Source:

Reference:

Builid

B r¥Ys i

Formats= B~

@ Secure | https//wwwiIvlhost.com TCS08/Defaultaspx?Page=%2fWidgets%2MVRs %25 1onyMVR % 2fStoryChildrenTask% 2fQuickAdd Contr

Bum Hours

Follow these steps to burn the hours:

Burn hours mean tracking the efforts put in for a task. For example, if a task has detailed
estimated hours as 8hr and a user has spent 2 hours on a particular day for the same task, it
is required to change the remaining hours for the task as 6hrs (8-2=6). With this, the hours
automatically get updated to 2 hours.

Go to the task where a user has spent the time and click on the Edit link present against

each row.
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¥ Backlog Item B-01019

QJ Sample: Enter RMA History Visualize Delivery | Edit W

Tasks 5 Tests 4 Downstream Dependencies 1 BacklogGoais 1 Links O Attachments 0
TUIAL DUNE rwcs
3700

{4 15015 p ) A
Title ) Owner Status  Detail Estimate Hrs. DoneHrs. ToDoMrs. =
3 Sample: Design Component TK01062 Sample: Alfred Smith In Progeess  8.00 12,00 200
% Sample: Build UI TK01063 Sample: Danny Developer InProgress 8.00 700 4.00 Edit v

3 Sample: Code Review TK-01064 Sampie: Tammy Coder, Sample: Danny Developer 400 400] -

% Sample: Update Documentation TK-01073  Sample: Claus Customer 10.00 400 Edit v

} Sample: Create Performance Tests ~ TK-01074 Sample: Danny Developer 400 4,00 Edit v

It opens the Task Details page in the edit mode. A user can edit the details of the task
using this option.

Scroll down the page and find the To Do Hours field.

Replace the To Do hours with the remaining hours. (Detail Estimated Hrs — Time Spent
in this task)

After that click on the Save button as shown in the screenshot below:

i VersionOne - Google Chome . R, W
@ Secure | https//www53.v1host.com/TCS08/Default.aspx?Page=//Widgets/Details/QuickEditTask&AssetContext=Task: 14498 Ref a&But
TaSk Cancel |
i
Tags:
Owners: Sample: Tammy Coder *  Sample: Danny Developer x
Status, il
Type: ‘ Admin ad
Source: | Planned i
Reference: "
Bulld J
Detail Estimate Hrs. |4.00
To Do Hrs.: l72‘(7)(;<| I
Done Hrs.:
- -
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Close/Quick Close a Task

Once all effort of a task is completed, it can be closed to claim the work done in the sprint as
well as backlog item. A closed task can be re-opened later if require. In this section, we will
discuss how to close a task.

Follow these steps to close a task:

e Go tothe Task and click on the Edit dropdown -> Close Task or Quick Close Task option
as shown below:

Sample: Enter RMA

Tasks 5 Tests 4 Downstream Dependencies 1 Backlog Goals 1  Links 0  Attachments O
TOTAL TO DO HRS. CREATE DATE CHANGE DATE
18.00 W01 T4 PM W20 &T5 PM
DONE HRS.

TOTAL DONE HRS.
3700

Tasks

Title [1+] Owner Status Detail Estimate Hrs. Done Hrs. To Do Hrs.
4 Sample: Design Component TE-01062 Sample: Alfred Smith In Progress 8.00 200

& Sample: Build Ul TE01062 Sample: Danny Developer In Progress 8.00 400

e ek R F-010e4 Sample: Tammy Coder, Sample: Danny Developer  Completed 4.00 000
Quick Close Task

Close Task
4 Sample: Create Performance Tests  TK-01074 Sample: Danny Developer 4.00 400 Delete

% Sample: Update Documentation  TK-01072 Sample: Claus Customer 10.00 400

¢ When a user selects Close Task, it opens a new window where a user enters the
remaining To Do Hours usually as 0.00 and selects the status as Completed.

e Now, click on the Close Task button as shown in the screenshot below:

[ VersionOne - Google Cheome

@ Secure | hittps/'www53vlhost.com/TCS08/ Default.aspx? Page=/ Widgets/Details/Tnactivate Task&AssetContext=Task: 14498 RefreshGadg

i ==
ID: TK-01064
Title: Sample: Code Review
Task To Do 0.00 !
Status: . Completed [™]
To Do will be clearad,
- -
tutorialspoint -8
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If a user selects the Quick Close option, it automatically changes the status as
Completed and closes the task.

After getting closed, the task title and the id are struck out. The Edit button is replaced
by the Reopen Task button as shown below:

Sample: Enter RMA

Tasks & Tests 4 Downstream Dependencies 1 Backlog Goals 1 Links 0 Attachments O

TOTAL TO D0 HRS. CREATE DATE CHANGE DATE
18.00 QZZOTF T PM TWIZ0T &5 PM

DOME HRS.

TOTAL DONE HRS.
3700

Tasks

4415005 b pl
Title [ Owner Status Detail Estimate Hrs. Dene Hrs. To DoHrs. ™
£ Sample: Design Component TKO1062 Sample: Alfred Smith In Progress 8.00 12.00 2.00

4 Sample: Build UI TKO1063 Sample: Danny Developer In Progress 8.00 700 400 Edit ~

R b R F01064 |Sample: Tammy Coder. Sample: Danny Developer Completed 4.00 0.00 Reopen Task
{3} Sample: Update Documentation TK01073 Sample: Claus Customer 10.00 4.00 Edit ~

5 Sample: Create Perdormance Tests  TKOW074 Sample: Danny Developer 4,00 4,00

) tutorialspoint 79

EIMPLYEAEYLEARMNINEG



21.VersionOne — Templates

VersionOne Templates allow creating and maintaining a grid-formatted repository. In this
repository, it contains common, reusable stories/backlog items or defects. Using this grid, a
user can:

e Create and manage story templates.
e Create and manage defect templates.
e Assign common repetitive tasks and tests to existing backlog items.

e Export templates to other projects.

Add a Template

Template helps to maintain uniformity throughout the project. It helps to write all the required
and optional details at one place. Usually, the Project Leads or users in higher positions of the
hierarchy can add a template. In this section, we will discuss about how to add a template:

Follow these steps to add a template:

e Go to Product Planner -> Templates as shown below. It opens the Template page.

Release
)| qQ Input |
gl Backiog FRong ¥ Add Backlog ftem Inline | v
o
(o] ﬂ 2 Backiog Requests
-
. P [ A~
Backiog G s Issues
bod Order t  Title el oo - Priority  Estimate Pts.  Project %
- 1 [*7 Sampile: Enter RMA " High 200 Sample: Release 1.0 Edit v
wr Regression Tests
s Backiog Goals
2 2 Sample: Inventory Levels Off in War =~ w Medium 100 Sample: Release 1.0 Edit v
1©]
3 [7 Sample: Add Shipping Notes High 5.00 Sample: Release 10 Edit v
4 7 Sample: View Daily Call Count Medium 500 Sample: Release 1.0 Edit +
@ Import
[ Sample: Hold Order High 200 Sample: Release 1.0 Edit v

e Click the Add Backlog Item Template or click the Add Defect Template. The Backlog
Item (Template) or the Defect (Template) page opens.
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/[ Templstes

€ C | § Secure | https//www33.vLhost.com/T Defaultaspxime TemplatesPage&feat-na 2 “t

W My Home v soarch Q B - B N 7

s Portfolio = Product Release Team Reports.
System (Al Projects)

|F§ack|0g Item Templates|

n h

Hof1 \v |
@ 2 Title (1] Status Priority Estimate Pts. Project %
. @ [E7 Sample: User Interface Story B-01033 Sample: Call Center Product Generate Backlog ltem
- Defect Templates I Add Defect Template
w Haoft A
Title o Status Priority Estimate Pts. Project -
[ Sample: Boris Defect D-01005 Future 025 Sampile: Call Center Product Generate Defect ~

Enter the template information into the appropriate fields (the required fields are Title
and Project).

In the Defect template, the Resolution and the Resolution Details are added.

Click on Save. The template gets added into the project.

T - aeaee— Wy

& Secure | https//www53.vihost.com,

Backlog Item (Template) [ sove [ sovoznew | savosview [[EEERENE

Project System (All Projects) ¥ *

B /7 YU & I rfomas> £B~ (= = I

il
i
i
]
%
L2l

Create a Story/Defect from Template

Once a template is created, user can add story/defect using the same. User can utilize template

to add details. In this section, we will discuss how to create backlog item using the existing
template.

Follow these steps to create a story/defect from the template:

Go to the Product Planners ->Templates. It opens the template page.

To add a story, click on existing template from Backlog Item Templates. Or,

To add a defect, click on existing template from Defect Templates as shown below:
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CECEEEn w— e e

= C | @ Secure | hitpsy/ /w53 Lhost.com TCS0

ywmvm Q - 7

Product Release Team

Portiolio

il [5acikioq fem Templates

o .

- { Mot} ) A~
@ @ Title ot Status  Priority  Estimate Pts. Project -

i |@ > Sampie: User Interface Story-aa | 801022 Sample: Call Center Product Generate Backlog ltem | -

% | Defect Templates
o) 4 -

0] - d 4 Hoft p M ?
Title o Status Priority Estimate Pts. Project 5

[ Sample: Boris Defect D-01005 Future 025 Sample: Call Center Product Generate Defect

o It displays the template details.
e User can click on Edit and change the details if required.
e After editing click on Edit Dropdown -> Generate Backlog Item to add a story.

e It will add the story and move the story into project. Upon clicking Generate Backlog
Item, a user can see a new Story ID.

Following screenshots display before generating a story from template:

T =

€ C | & Secure | hitpsy/wwwS3.v1host.com/TCS08/Defaultaspx?menu=Template

klog Item B-01033

Sample: User Interface Story-aa

Attachments 0

PROJECT * BACKLOG GROUP STATUS PRIORITY Plan Backlog ltem
Sampso: Call Contar Procuct Add Task
SPRINT PORTFOLIO ITEM DATE COMPLETED CLASS OF SERVICE
W2220TT T4 PM Add Test

fram OWNERS ESTIMATE PTS. COMPLEXITY Copy

Delete
DELVERY CATEGORY CODE COMPLEXITY RANK (0-100) -

Following screenshot displays after generating a story from template:

I

€ C | & Secure | https//www53.v1host.com/TCS08/Defaultaspeimenus=Temp

¥ Backlog Item B-01050

Tasks 2 Links 0  Attachments O
Plan Backlog ltem

HOJECT * BACKLOG GROUP STATUS PRIORITY TASK 5 Add Task
Sampso; Call Contar Procuct Hdd Test

SPRINT PORTFOLIO ITEM CATE COMPLETED CLASS OF SERVICE TEST 5|
Generate Parent Portfolio Rem
- TAGS
fram OWNERS ESTIMATE PTS. COMPLEXITY CDD)'
Sign Me Up

CODE COMPLEXITY RANK (0-100)
ELIVERY CATEGORY
DELIVE EGOI Block '

Spilit
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Similarly, a user can add a defect from the template.

e Click on Edit to change details.
e Now, click on Edit Dropdown -> Generate Defect.

e It provides a unique defectid and the defect moves to the project.

Move a Template to another Project

VersionOne provides unique feature to move an existing template to another project. One
template can be used across all projects to maintain uniformity at the company level.

Follow these steps to move a template to another project:

e Go to Product Planner -> Templates. It opens the Template page.
e Check the checkbox of the template that needs to be moved.
o After checking the checkbox, Click on the Move To Project button as shown below:
)/ et e ——— e ——— A

€« C | @ Secure | httpsy//wwwS53v1host.com/TCS08/Detaultaspx?menu=TemplatesPage&ifeat-navs --m3 1r

‘y My Homa ~s saarch Q - O

Product

Release Team

Project (Al Projects) Portfolio

Backlog ltem Templates Add Backlog ltem Template
7] -
L L]
s §| Move To Project | + Hof1 A
7 E 8 Tite ot Status  Pricrity Estimate Pts. Project -
Fa
. E & [ Sample: User Interface Story-aa 8-01033 Sample: Call Center Product Generate Backlog Iem |
@8 [Defect Templates Add Defect Template
0| - Hof1 A
Title o Status Priofity Estimate Pts. Project o]
[ Sample: Boris Defect D-01005 Future 025 Sampile: Call Center Product Generate Defect ~

e A pop-up window appears wherein, a user selects the project to move the template.
Now, click on the Move button as shown below. It will move the current template to
another project.

[ Temptates

&« C | 8 Secure | https//wwwS3.v1host.com/T

Project] System (Al Projects)

System (All Projects)

Sample: Company ) Mph thelr Parent Backlog ftem.

to the selected Project

{ +10of1)

D Project

7 Sample: User Interface Story-aa 8-01032 Sample: Call Center Product
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22.VersionOne — Import Data

VersionOne supports to import data to create stories, defects and other data from excel
Consider the following to import the data from excel.

e Rules for Excel file

e Import the excel file into system

Additionally, VersionOne provides a template to import data. A user can download the template
to utilize.

Download Import Template:

VersionOne provides sample template to import. It is a combination of required and optional
fields. A user can enter the details based on the requirement. In the following section, we will
discuss how to download the sample template.

e Select Product Planner -> Import. It opens the Import page.

e Click on the Download Basic Excel Template to download basic template. It is used to
import the backlog items such as stories, defects, tests, tasks, etc.

e Click on the Download Advanced Excel Template to download advanced template. It is
used to import more complex system assets, such as projects, iteration schedules,
change sets, requests, etc.

Following screenshot displays how to download template:

Release

s 10 speed yout import file croation. Ploase
amiing your import:

Backlog Groups Issues

*AssotType®. The column itsolf should contain the
Nic assot types aro iIncluded in the comments in
Select a Template Regression Tosts §
Backiog Goals

ule data 10r the Now assot. Tho column hoadaor

Download Basic Excel Template umn 2solf should Contain the Coresponding
Tomplates
_ et e

Import backlog

Upload A Completed Excel Template File * To maintain data integrity, each Import s conductad within a singlo transaction. For this reason, and

10 recohe quicker foeddack, we recommaend Imiting your import 1o 500 toms por import il
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A basic Excel template looks like the following:

AssetType Name Scope Description | Estimate Priority

An advanced Excel Template looks like the following:

AssetTyp | Nam Scop Descriptio Swa Referenc Statu Priorit Ris Sourc Categor | Owner Supe
e e e n g e 5 y k e y S r
Rules for Excel File

Every template has some basic rules/checkpoints to be considered before importing the data.
If these checkpoints fail, data will not be imported and error message displays. In this section,
we will discuss the excel rules:

Consider the following points while creating an excel file:

Y

The header of the first column should always be "AssetType". The column should have
the system name for the asset type. The system names for basic asset types are
included in the comments in the templates. For example, for story it should be Story,
Defect for each Defect and Issue for each issue, etc.

The attribute data for the new backlog item should go to the remaining columns. The
column header should be the name of the attributes. The column should contain the
corresponding attribute value for that asset.

Worksheets are imported into alphabetical order of worksheet name. In the same excel
file, a user can reference a work item that was created in an earlier worksheet. For
example, to create a project and stories within the project, first add the project in the
first worksheet and then add the stories in the new project in a second worksheet.

The backlog import template includes system names for default assets and fields. To
include other assets or fields, including custom fields, please contact system
administrator for the corresponding system names. User canremove unnecessary fields
by deleting the column.

To maintain data integrity, each Import is conducted within a single transaction. For
this reason import is limiting to 500 items per import file.

In the advanced template, there are 7 worksheets to upload 7 different items in single
transaction. The Epics, Stories, Tasks, Tests, Defects, Requests and Issues form the
order of the worksheet.
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Import Excel Fie

Data can be imported into VersionOne using excel file. A user must check the checkpoints of
the excel sheet before importing it. If the imports are successful, a user will get success
message along with the imported count otherwise an error message displays. For partial
successful import, both success and error message get displayed. In this section, we will
discuss how to import the excel file.

Follow these steps to import the excel file:

Go to Product Planner -> Import and clickon Upload A Completed Excel Template File as shown
in the screenshot below:

/ Il tmport x WY o= G
“ C | @ Secure | https//www53.v1lhost.com/T fault.a me tPage&ifeat +4
y MyHomo v search Q e Qe

Portfolio Product Release

+

; Helpful hints
& Import your backlog using Excel
CREATING AN EXCEL IMPORT FILE
:: VersionOne Excel-based Import Templates can be used to

Import backiog items In bulk into VersionOne. Our import tomplato containg holpful formatting and commeonts 1o spead yout import filo croation. Ploase
Sart with & tomplate If you can. Hore aro & fow More s 1o SHOAMING your Import:

« The hoader of the first column shouid aiways ba "AssolType”. The column itsolf should contain the
system name for the assot typa. Systom names for basic assot types aro included in the comments in
the tompatos.

Select a Template

»  Tho remaining columns should contain the attribute data 1or the Now assot. Tho column hoador
Download Basic Excel Template should be the system name of the attribwte. The column Rself should contain the corresponding
attribute value for that assot.

» Workshoots are processed in aiphabotical ordor by workshoot name, 50 within the same oxcol o,
Download Advanced Excel Template YOU Can reforence 3 work ifom that was created in an oatiior workshoot. For oxamplo, 10 croato a
projoct and stories within the project, add the project In the first workshoat. and thon sdd the stodes in
e now project in & second workshoot

C
~

I " + Tho backiog import tomplato Inchudos systom names for dotaust aszots and fiekds. To includo other
mport backlog 350t of fiokds, Including custom ficlds, ploase Contact your systom adminiztrator for tho
Conozponding system names. You Can romove Lnnocezary floids by delting tho column

Upload A Completed Excel Template File » To maintain data integrity, each Import ks conductad within a singlo transaction. For this reason, and
10 rOcoNe QUIKKOr FoedbWCK, We recommand Imiting your Import 1o 500 toms par import 4.

An Excel Import pop-up appears wherein, a user browses the file and uploads. Now, click on
the Import button as shown below:

/ [ import x \ . v = i (e

< C | @ Secure | https//www53.v1host.com/T efault.aspx?n tPagefifeat e

Choose flie |Basic_Backlog_)..t_Template xls
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e Once the import is done, a successful message displays or an error displays if there is
any data issue.

e It also displays the type of asset imported and the total number of assets imported.

The following screenshot shows a success message:

/T o Fhanglin I _Lee———m USSR

&« C | @ Secure | https//wwwS53.vlhost.com/T w

Choose file | Basic_Backlog_l..t_Template xis
|Im it Succeeded: 1 I

+c: Backlog ltem

ted: 1
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23.VersionOne — Team Rooms

TeamRooms is the place where a user can track and view the progress at the project level as
well as sprint level. In TeamRoom, day to day progress can be tracked at the individual level.

To access the team Rooms, go to Team Planner -> TeamRooms as shown in the screenshot
below:

Portfolio Product Release

+ Sprint: | Sample: Month C tst Half v | Team:| (Al
@ Sprint Schedufing Detall Tracking Close Sprint ToamRooms
Taskboard
1]
-
150f5 Momber Tracking
8 M Dotad Planning Rotrospectives
&4 2
Member Planning Storyboard

e It opens the TeamRooms created for different project/release. A user can click any of
these to see the corresponding details.

Add a Team Room

Usually, a scrum master adds the TeamRoom. Let us now see the steps to add a TeamRoom.

¢ Navigate to Team Planner -> Team Rooms. It displays the Team Rooms page with all
the available rooms.

e Toadd a Team Room, click on the Add TeamRoom button present at the top right.

Portfolio Product Release
gl [TeamRooms Add TeamRoom
[ —
(O] +1of1 Av |
Tl Mascot Title D &
-
@ Sample: Call Center T Roo Delete

e It opens the Add TeamRoom window, where a user can enter title, select Team Flow
and schedule.

e Now, click on the Save button present at the bottom of the page.

e Note: Users having Team Lead or above roles can only add a TeamRoom.
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The following screenshot displays how to add a TeamRoom:

/B TesmRooms * F_

- C | @ Secure | httpsy//www53.v1host.comT

arme your TeamRoom and then select a project in which your role is Project Lead or above, Only members with
Project Lead access to a project can add a TeamRoom,

You can adjust the TeamBoom focus using the project filters, After you've created your TeamBoom, personalize it
by adding a mascot and members from the TeamRoom settings.

Title: *

Sample - Version

~ System (Al Projects)
» Sample: Comparry Team Flow:

Sample-Version

& Program:
(Al v
Optionally saloct a Progrm to furthor

narrow the focus of your TeamRoam.

2 Team

TeamRoom Panels

TeamRoom consists of many important details. In this section, we will discuss the details
displaying into TeamRoom.

e To view the TeamRoom detail, go to Team Planner -> Team Rooms and click one of the
available rooms.

e By Default, Backlog is selected. Otherwise, click on backlog to display the backlog items
in the left side.

e Click on the additional panel tab to display the items as explained below:

Panel Description

e Displays unscheduled backlog. These items might fall
into sprints by grouping backlog items into sprint based
on their estimates and the current average velocity.

e Items display in rank order, with the highest ranking at

Backlog the top.

e The item's estimate is also display if an estimate value
exists.

e Drag and drop the backlog items between columns to
update the status.

Storyboard e Shows all the stories (displayed as story cards) in
a sprint/iteration in the selected sprint.

e Displays tasks grouped by story, defect and by task

Taskboard status in the selected sprint.
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Testboard o Displays acceptance tests grouped by backlog item,
defect and by test status in the selected sprint.
. . e This panel shows a list of work items in the selected
List View .
sprint.
e Allows reviewing the closed work.
e Items are grouped by their sprint and sorted by sprint
Closed start date.

Item estimates display when assigned to the item and
estimate totals display on the sprint.

Conversations

Shows all conversations started in the room as well as
conversations that mention work items in the room.

Activity Stream

Shows all the activity that has occurred on the assets in
the TeamRoom.

Items display in reverse-chronological order and only
display once in the list based on the most recent
change.

Estimably

Allows the creation of an Estimably estimation game.
After starting a game, drag items from the Backlog
panel into this panel to estimate them. Note that when
user submits the results of a game, the estimate for that
item is also updated.

Scorecard

Instant access to a barometer of key project
performance indicators at the project, program,
portfolio item, and team level.

Topics

View Communities Topics  directly within the
TeamRoom.

The following screenshot displays the TeamRooms overview:

A
[ Semple: Call Center Tear X

‘ My Home v search

.9 @

- C | 8 Secure | https//www53.v

1host.com/T

Q

Sample: Call Center TeamRoom #

2 @ @

VELOCITY 200

= Sample: MonthC v Rm
@ 14,67 .
Sam 5 IIII-- J,‘_,, 3372 3 1112912 1/29

ampic: W Totst 25 pis

[Nl Storyboard

[*7 Sample: User Interface Story

Testboard List View Closed l Conversations l Activity Stream Estimably Scorecard Topics

+50f5 ) Mghlight Owner BLEGEND | v
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24.VersionOne - Storyboard

Storyboard displays the committed stories in the sprint. It displays the stories as card under
different status categories. The Agile team uses the storyboard to track the progress of each
story from the day 1 of the sprint to the completion of stories and acceptance by the product
owner. Storyboard’s progress is highly visible and team members can identify easily the newly
added stories in the sprint and what progress is done in the product development lifecycle.

To access the Storyboard, go to Team Planner -> (Sprint Tracking)-> Storyboard as shown
below:

[ Storyboard x — St =G

<« C | @ Secure | https//wwwS53.v1host.com/T fault t e )

A%

Portfolio Product Release

Sprint Planning Sprint Tracking Review TeamRooms

it Sprint:| Sample: Month C st Half v [ Team:| (Al
@ Sprint Scheduling Detall Tracking Close Sprint ToamRooms
Storyboard
-n
L L]
Member Tracking Rotrospectives
8 v Dotadl Planning s v
\ 601021 4 O v || Y -
Sample: View Daily Call Count Sample: Enter 4 15 Toskboord
Sampio: Alfrod Smith .00 Sampic: Tammy
0.~ Testboard
Sample: Pick Lists Reversed Sample: Add ¢ .

Samplo: Andro AQ 200 Sample: Andro

ViewUpdate Story Detais

A user can view/edit all details of the story including title, priority, estimation and
dependencies. The only unmodified field is the unique id of the story, it can never change or
get modified. It is similar to the backlog section.

Follow these steps to update story details at Storyboard:
e Go to Team Planner -> Storyboard. It displays the Storyboard page.
e The Storyboard page opens. Here, a user can see different categories as status and
stories are placed under different status.

The following screenshot displays the storyboard details:
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Product

Portfolio

Release

VersionOne

=
s [+]
¢ %20

Sprint:| Sample: Month C 15t Half » | Team:| (Al v
= Storyboard Highlight Owner | A |
L1} Y .
nu
”:" (None) | Future | In Progress | Done | Accepted
) Ty v ® ~ ® ~ ® -
@ Sample: View Daily Call Count Sample: Pick Lists Reversed Sample: Enter RMA Sample: Export Missing 1D Column
L o ~
Sample: Add Shipping Notes
e To view the basic details, hover over the title or ID. It displays the basic details of the
story like title, id, description and estimation.
e To see the full story details, click on the story title or ID.
[ ]

Click the dropdown and select the Edit button, and then modify the story details.

The following screenshot displays the story details and options:

[ Storybosrd —— e et e
< C | a r e [+)
AR Q °o% 20

Highlight Owner

(A

—

D >

Sample: Export Missing 1D Column

Portfolio Product Release
+ Sprint | Sample: Month C 1st Half v | Team:| (All) v
i~
&
Storyboard
-n
s
(Y| ¢
o) Y v | 50101 4
@ Sample: View Dally Call Count Sample:| Eqit Sample: Enter RMA
San d Sem Sampio Copy Sampic: Tammy Codor
C} Assign
Track
Sign Me Up
Block |

Quick Close
Close
Convert To Backlog ltem

Watch Defect

in the dropdown.
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Update Story Status

The story status displays the current stage of story. Storyboard is categorized into various
statuses to provide the current stage of the story. The status can be customized by the admin.
In this section, we will discuss how to update the story status:

e The status columns in the storyboard are as follows - None, Future, In Progress, Done,
Accepted.

e To update the status of a story from storyboard, go to Team Planner -> Storyboard.
e Drag and Drop each story horizontally to a status column to update it.
e A user can update the status of a story at the other board as well.

The following screenshot displays how to update status:

Portfolio

Speint: | Sample: Month C fst Half v | Teamc| (Al

Storyboard Highlight Owner A

(7] v
500 4 v || Q O v | O @ ||| [CEED O v

Samgpile: View Daily Call Count Sample: Pick Lists Reversed Sample: Enter RMA Sample: Export Missing ID Column sample: Add Shipping Notes

—
Sampic: Alired Smith 800 Samplo: Andro Agiic 200 Sampic: Tammy Codar 2000 Sample: Andre Agita 200 Sample: Andro Agile 5.00

Name (o7 Pk

Sample: Andre Agile
SHOAT NAME
Sample: Af
EMAL

. TE
\ S e B (e
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25.VersionOne — Testboard

Testboard displays the list of acceptance tests foreach backlog item and/or defect. It displays
the current status of test as well; whether passed, failed or none. It is useful to view the status
of each test to track the progress of individual tests during the testing cycle.

To access Testboard, from the main menu, select Team Planner -> Testboard as shown below:

Portfolio Product Release

Sprint:| Sample: Month C tst Half v | Team:| (Al)

@ +

Testboard

{ 150f5

- =X

Sampie: USPS Form

Sample: Boris Testor

Sample: Add Shipping Notes

Sprint Planning

Sprint Schoduling

Dotadt Planning

Member Planning

Issues.

Deotall Tracking

Member Tracking
Storyboard

Taskboard

ssuos

e A user can select the Sprint from the top left side to see the details of the respective

sprint.

e Test Cards appear in different status columns on the board (for example, None, Passed

and Failed).

e It shows the test title, owner, and total work estimate.

e Test cards are color-coded by test type (i.e., Method, Type, Manual, Automated) to give

a look at the testing across project work functions.

e Click the Legend button at the top right of the board to see the color representation
and/or to customize the color-coding scheme by the test type.

The following screenshot displays the Testboard view:
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/i Testboard Ll —— it )l
< C | & Secure | hitpsy//www53v1lhost.com/T Defaultaspcimenu=TestBoardPageSifeat-na na e [+
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Portfolio Product Release
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Update Test Status

In this section, we will discuss how to update test status.

e The Testboard has the following status columns - None, Passed and Failed.
e To update the status of a test from Testboard, go to Team Planner -> Testboard.

e Drag and Drop each test horizontally to a status column to update it.

Following screenshot displays how to update status:

L2 C | @ Secure | hitps//wwwS3.x1host.com, 3/ Default.aspxImer tBoardPagefeat & o

" My Homa w soanch Q LA - 07

Portfolio
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Reports on Testboard

Reports on Testboard are data displayed in trend/charts to analyze the continuous progress.
There are usually four types of reports available on Testboard.

A user can access these reports by navigating to Testboard and clicking on Reports -> Name
of Report present at top right as shown in the screenshot below:

https//www53.v1host.com/T

¢«
Ywmv search Q LA - B 22 ]

Release

Portfolio Product

3 This Paae
Sprint:| Sample: Month C 1st Half v | Team:| (aip Report On This Pag

All Roports Standup Dashboard

Testboard : Test Trend

4 41505 ) ) Scoracard Test Runs

ﬂ v Burndown
Project Burndown

Standup Dashboard Report: It displays a high-level view of team progress through its sprint
workload. The dashboard displays continuous graph of the remaining work To Do and the
cumulative flow by status where date is x-axis. It also displays the current view of the

Testboard. The following screenshot displays the Standup Dashboard Report:

/ [l Testboard 3 ’h Standup Dashboard » —— . = o| (e
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owe
- |deal Line - To Do M iNone) I Future In Frogress Done
Storyboard Taskboard Testhoard
Testboard Highlight Owner: 3 LEGEND | A |
15af5
- Samplo: Ordor Number we Samplo: RMAS over e Tasks:
Not Found $500 -
Sampie: Enter RMA Sample: Baris Toster 0.00 Samplo: Boris Toster 0.00
W Samplo: Store Credit w Samplo: RMAS under  ~
ER— fioe all roturms. $500
' Samolo; Bocs Toster 200 Samolo: Borks Tostor Q.00 b

Test Trend Report: It displays the bar graph to show how the status of the tests has changed
over a period of time. It displays color-coded bars; this indicates the number of tests in specific
status (not yet run, passed, failed, etc.) at specific milestone dates. The following screenshot
displays the Test Trend report:
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Test Trend | prinmt || POF |
Sprint eam Backlog Group

Al v| [an v| [an v a Reset |

Workitem Start Date Duration Show All Projects
All v | |09/2272017 7

M (None) M Falled passed

e Test Runs Report: It displays the bar graph showing project-level test results from an
external testing system by test status (for example, not yet run, passed, failed).

e Burndown Report: It displays the progress of a team through its sprint workload. It
displays the amount of work done and remaining to be done (To Do) versus the
expected (ideal) schedule.
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26.VersionOne — Taskboard

Task board represents the different tasks available in the sprint and grouped by backlog item
and/or defect. Each task is associated or categorized by task status. Taskboard is used during
the team's daily meeting to get a quick progress of the overall work within the team's sprint.
A user can track the progress by moving tasks to a different status.

To access Taskboard, from the main menu, select Team Planner -> Taskboard.

[ Tesiooard

&« C | @ Secure | https

53.vlhost.com/T fault KE t o o
‘ My Home v search Q Cn Qe

Portfolio Product Release

Sprint:| Sample: Month C tst Half v | Team:| (Al) v Sprink Plencing Sprint:Trecking Review TeomRoonts

Sprint Schedufing Detall Tracking Close Speint TeamRooms

Taskboard
f Membeor Tracki
+50f5 Dotadt Planning erslipiapos. ) Rotrospoctives
&4 <
Member Planning Storyboard
_-
Issues
G amp dato ) .- A Taskboard
Sample: Enter RMA v

&

v Samplo: Build Ul
Sampio: Tamemy

Sample: Add Shipping Notes Codos | > I
Smith 000 To Do

Samplo: Sorvico v e 16.00

Chango

Sample: Andro Agile 100

Samplo: Design Layout v Test Results: h

e On the Taskboard, Tasks are displayed in different status columns (for example, None,
In Progress, Completed).

e Task card displays the task title, owner and total work estimate.

e Task cards are color-coded by type (i.e., Design, Code, Admin) to provide an at-a-
glance look at the balance of work across project work functions.

e Click the Legend button at the top right of the board to see the color representation
and to customize the color-coding scheme by task type.
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The following screenshot displays the Taskboard:

[ Teskbosrd

VersionOne

www53.vlhost.com/T

Q

Portfolio

Product

Release

+ Sprint | Sample: Month C 1st Half v | Team:| (Al) v
]
& -
Taskboard Highlight Owner i LEGEND A v
-n A
s
{ 150f5 Type
B {(None)
(7| < o
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Admin
e}
CUSTOMIZE
= + | Samplk: Upaate o Sampic: Bulkd UL v
g Documentation Sample: Danny
Sample: Enter RMA Samplo: Claus Devolopor 400
Customes 400 To Do
8 e 400
k. Sampio: Croate v
400
« | Sampio: Update v Sampic: Bulld Ul v Sample: Dosign v Test Results:
i Documentation Samplo: Tamemy Component -]
Sample: Add Shipping Not Samplo: Claus Codor 3100 Samplo: Alfrod
Customer 200 Smith 000 To Do
= Somplo:Sorvke. v 16.00
Change
HaNple: Andm Sample: Andro Agile 100
Aok . 2mp ro Ag 0
A 5.01021 4 « | Sampio: Service - Sampilo: Dosign Layout Test Results: -

Track/Update a Task

A task can be updated from the Taskboard. A user can track and later update efforts spent for
the task. A user can update the overall status of the task as well. Consider the following points
related to the updation of a task.

e When a user hovers over Task title, it displays a detailed description of the task. To
update a task, open the dropdown menu in the top right corner of the card.

e Select the appropriate action (edit, assign an owner, assign yourself, track the effort
and To Do for the task, close, or watch the task) as shown below:

™ m —— e

3.vlhost.com/T . o

____

Samplo: Update s 'v'pk Build Ul Tc- t Results:
Er M Documentation
Sample: Enter A Sampio: Claus Den Edit
Customer 400 | A To Do
ssign 14.00
Track
Sign Me Up
Quick Close
« | Sampio: Update v b | oS Samplo: Design v Test Results:
Documentation Sanf) Componont =4
Sampio: Claus Cod | Watch Task Sample: Altrod
Customes 200 Senith 000 To Do
e Samplo: Servico 16.00
Change
Samplo: Andro Agllo 100
v | Sompl: Servico ~ Samplo: Dosion Layout Test Results:
S Chango Sample: Alfred
mple: Viey ih all Count
Sample: View Dally Call Count | § samote: andre Agke 15.00 Senith 000
—— To Do:
Atred Sompie. Upcato - - 35.00
)0 Documentation
Samplo: i 000
Cestomer | TK01072 2
; 22 E
5 Ssmple Updale Documentation Test Results:
Sample: Pick Lists Reversed Up(!at ocumentation to reflect this new functionality. Include updates to To Do
= the glossary and index as appropriate when making content change 0.00
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To change a task status, click and drag the Task Card to the appropriate status column
in that row.

As work progresses, enter Effort and update the remaining To Do hours for each task
via the Edit function on the Task Card dropdown menu. Now, click on Save as shown in
the screenshot below:

[ VersionOne - Google Chrome - T ————

ln Secure | https://www53.v1lhost.com,

-Task |m ETCJ_} )

Tags

Owners Sample: Danny Developer x

Status In Progress ¥

Type Code |

Source Planned v

Reference:

Bulld

Detail Estimate Hrs 8.00

To Do Hrs 4.008!

Done Hrs. 700

- -
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27.VersionOne - Filters

Filters are used to narrow down or expand the lists of items displayed in a page. It helps to
focus on items that are important.

Filter is available on each page and section at the left side as shown in the screenshot below:

\
[ Bociiog x | o s
— C | @ Secure | https//wwwS3.v1lhost.com/T fault. ack afifeat 4 (¢
‘ My Home search Q O & Q2 O
Portfolio = Release Reports
Add Backlog ftem Inline I'v
Clear All Filters
Backlog Group
1-230f 23 -\v
Owner
R (] Owne Priority  Estimate Pts. Project ‘e
Portfolio tem
Priority » fjtory Levels Off in Warehouse D-01001 Sample: Alfred Smith Medium  1.00 Sample: Release 1.0 Edit v
Rollup Cat
s hoaces et 4 ? ists Reversed D-01002  Sample: Andre Agile Medium  2.00 Sample: Retease 1.0 Edit
(@7 Sprint >
Status > it Missing ID Column D-01003 Sample: Andre Aglie Medium  2.00 Sample: Release 1.0 Edit +
g Tags
| Shipments Doubled D-01004 Low 050 Sample: Call Centor Product Edit v
Team > HDefect D-01024 025 Sample: Call Center Product Edit v
Workitem ’
Defect D-01025 025 Sample: Call Center Product Edit ~
O Show Closed ltems
Defect D-01026 025 Sample: Call Center Product Edit +
D Show Tasks and Tests
Defect 001027 0.25 Sample: Call Center Product Edit +
More Filters. ~
9 ample: Boris Defect D-01028 025 Sample: Call Center Product Edit ~
10 ™ Sample: Boris Defect 0-01029 025 Sample: Call Center Product Edit v
1 ™ Somnle Tiucedsu bmanet Nafort Doin Ao i wen Lon Samnla Call Cantar Deadort Eodis o it

Filter Specifications

Filters come with a wide range of options and features. A user can make use of the filters
according to his requirements. Consider the following are few important features of filters:

e Select multiple filters at a time.

e Add multiple values for each field.

e Filter by more than one Owner, Team or Priority.

e Filter checkboxes, dates and numbers.

e Use LESS THAN and GREATER THAN.

e Use BEFORE and AFTER, in addition to IS.

e Press the Enter key while typing in the Find supported filter field.

e Use the CTRL4+SHIFT+F keyboard shortcut to invoke the filter options.
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How to Use Filter

The use of filters helps to get the desired data on the page and trim off the unwanted data
from the user perspective. Following steps display how a user can utilize the filter functionality:

Click on Filter dropdown that displays the all available option.
A user can select any of the option at a time.

If sub-options are available, a user can select those as well. For example, Status ->
Future, In Progress, Done, Accepted.

Priority -> Unassigned, Low, Medium, High; Similarly, Team, Workitem, Rollup
Category, Sprint, etc.

After selection, click on Apply (if sub-option is present), otherwise filter will be applied
directly as soon as selected from dropdown as shown below:

/ [l Baciiog x ¥ © () mulkabeez trailer - X — . — Jas| e
< C | @ Secure | httpsy/www53v1hostcom Default.aspx?menu=PrimaryBacklogPagefifeat-na 2 i L+
W wrme v saren Q CRE - )
Portfolio Product Release Team
+ Backlog Add Backlog ltem Inline | ~
&
< E Priority /i
s S—
L e | A~
w Order +  Title ® (Unassigned) Priority  Estimate Pts.  Project “
o Hems with no WorkilemPriority
1 [7 Sampile: Enter RMA High 200 Sample: Release 1.0 Edit
2 [ Sample: Inventory Levels Offin Wd|  Low Medium 100 Sample: Release 1.0 Edit
o)
3 [7 Sample: Add Shipping Notes Mediurm High 5.00 Sample: Release 1.0 Edit w
4 [ Sampie: View Daily Call Count High Medium  5.00 Sample: Release 1.0 Edit ~
[0}
5 [7 Sampile: Hold Order B-01022  Sample: Danny Developer High 200 Sample: Release 10 Edit w
[ [T Sample: Pick Lists Reversed 001002  Sample: Andre Agile Medium 200 Sample: Release 1.0 Edit ~
7 [F Sample: Update RMA B-01023 Sample: Danny Developer Medium 200 Sample: Release 1.0 Edit ~
g8 [ Sample: Export Missing ID Column D-01003  Sample: Andre Agile Medium 200 Sample: Release 1.0 Edit ~
] 7 Sample: Multiple Ship-To's B-01024 Sample: Danny Developer High 5.00 Sample: Release 10 Edit ~
10 [ Sample: Calculate Tax B-01025  Sample: Danny Developer High 5.00 Sample: Release 1.0 Edit
1 [ Sample: Delete RMA B-01026 High 2.00 Sample: Release 10 Edit ~ 7

After selection, a user can see the selected filters at the right side of the filter as shown
below:

[ Bocicg x — - . e
- C | @ Secure | https//www53.vlhost.com/T fault.a ack feat-na b 4 O
y My Home search Q O &2 0
Portfolio Product Release
e Backlog Add Backlog ltem Inline =~
&
= a v | piomyis Low Workitom is Defect Clear All Filters
==
. v 160f6 Av
R Order * Title (4] Owner  Priority  Estimate Pts. Project =
1 [ Sample: Partial Shipments Doubled D-01004 Low 050 Sample: Calt Center Product Edit v
p 2 [™ Sample: Wrong Address on Invoice 0-01015 Low 050 Sample: Call Center Product Edit
1©
® 3 [™ Sample: Orders Shipping to BiliTo Address D-01016 Low 050 Sample: Release 1.0 Edit v
4 ™ Sample: lcon Background is Wrong Color D-01017 Low 050 Sampie: Release 1.0 Edit v
™ Sample: Processing Fiiter Misalignment D-01020 Low 1.00 Sample: Release 1.0 Edit v
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Clear Filter

After the application, a filter needs to be cleared as well. Next time, this makes it easy for the
next user to fetch the details. In general terms, clear filter allows to display all details at the
page.

To clear a single filter:
e Click on the *-' symbol next to the name of the filter.
To remove the applied filters, restore the default settings:

e Click Clear All Filters in the top right corner of the page.

The following screenshot displays how to clear the filters:

[ Baciiog

C | & Secure | httpsy/www53.v1lhost.comT Defaultaspximenu=Prim scklogPagefidfeat-na 2 r [+ ]

(_
W remesv son Q o %20

Projct

System (All Projects) Portfolio

Backlog Add Backiog ltem Inline | v
- Priority is LWD Workitom is Dcr-.\(D

Product Release Team Reports

~ t60f6 A |
Order t Title ID Owner  Priority  Estimate Pts. Project - o

[T Sample: Partial Shipments Doubled D-01004 Low 050 Sample: Call Center Product Edit ~

2 [T Sample: Wrong Address on Invoice D-01015 Low 050 Sample: Call Center Product Edit ~

3 [ Sample: Orders Shipping to BillTo Address D-D1016 Low 050 Sample: Release 1.0 Edit

4 ™ Sample: lcon Background is Wrong Color D-010M7 Low 050 Sample: Release 1.0 Edit

E) [T Sample: Processing Filter Misalignment D-01020 Low 100 Sample: Release 1.0 Edit ~

3 ™ Sample: Processing Filter Disappears D-01022 Low 100 Sample: Release 2.0 Edit
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28.VersionOne — Search

VersionOne supports the search functionality, it helps to find specific details within VersionOne
as well as narrow down the displayed details.

Search functionality is categorized into two:

e Quick Search: Search for open workitems, Conversations and Community Topics.

e Advanced Search: If a user wants to search Closed or Deleted Workitems, use Advanced
Search.

Quick Search

Quick search is simply a wild card search where VersionOne tries to get all records that fulfil
the text match. Follow these steps for quick search:

e Quick Search is located at utility bar, on the top of every page.

e It searches open workitems, conversations and community topics.

e Auser cantype 3 characters or ID into the search text box. If a user pauses after typing
3 characters, a preview of matching Open workitems displays. If a user keeps typing,

the matching results become more refined.

The following screenshot displays how to use quick search:

i Baciico s &
&« C | 8 Secure | http T w [+
V sy [
Backlog ltems - Product PR
[ B-01021 Sampie: View Dally Call Count
Defects
™ p~0|021 Samp!r{ Error - edit item
oo At i e et 1250155 b Pl (A~
Order t  Title D Owmer Priority  Estimate Pts. Project %
1 [*7 Sample: Enter RMA B8-01019 Sample: Tammy Coder High 200 Sample: Release 1.0 Edit v
2 [™ Sample: Inventory Levels Off in Warehouse D-01001  Sample: Alfred Smith Medium 100 Sample: Release 10 Edit v
3 [*7 Sample: Add Shipping Notes B-01020 Sample: Andre Aglle High 5.00 Sample: Release 1.0 Edit -«
I3 Sample: View Daily Call Count 801021  Sample: Alfred Smith Medium 500 Sample: Release 1.0 Edit
5 [*7 Sample: Hold Order B-01022 Sample: Danny Developer High 200 Sample: Release 1.0 Edit v
6 [™ Sampie: Pick Lists Reversed D-01002  Sample: Andre Agite Medium 2,00 Sample: Release 1.0 Edit v
7 [7 Sampie: Update RMA B-01023  Sample: Danny Developer Medium  2.00 Sample: Release 1.0 Edit ~
8 [™ Sample; Export Missing 1D Column D-01003  Sample: Andre Agile Medium  2.00 Sample: Release 1.0 Edit
9 I Sample: Multiple Ship-To's B-01024  Sample: Danny Developer High 500 Sample: Release 1.0 Edit v
10 [ Sampile: Calculate Tax B-01025  Sample: Danny Developer High 500 Sample: Release 1.0 Edit ~
1 2 Sample: Delete RMA B-01026 High 200 Samople: Release 1.0 Edit ~ ~
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Advance Search

VersionOne supports the advance search functionality. It helps to provide specific data that a
user wants to search. Follow these steps for advance search:

e In advance search, a user can search specific asset type, closed and deleted workitems
as well.

e To open the Advanced Search page, click on Quick Search box and then press
ENTER/RETURN key.

e Alternatively, a user can click on the Search icon present after the search text box as
shown below:

[ Baciog x ¥ [ Advanced Search x b &
€« C | @ Secure | https://www53.v1host.comT bd L 4]
— -
YV Mromo search Q K- )
= Product Release Team
+ Backlog Add Backiog tem nfine |

The Advanced Search page opens in a new window. A user can type a word that is to
be searched and click on Search.

e Additionally, before/after clicking search, a user can narrow down the search further by
selecting the Open/Closed/Delete checkboxes. Following screenshot displays how to do
advance search:

[ Baciiog var!_h_'m:e: are x ¥ — et o=
(_ c 0 Secure https/fwwwi3.vlhost.com/T ﬁ

1021 I | Search |

Closedw. Deleted v I

Open

Al tems

Backlog ltems

Defects Tasks Tests Re-quests lssues

Title (=] Project Change Date +
LS Hydt AT Sample: Release 1.0 WA2017 6:14 PM
R ] Sample: Release 1.0 10AB2017 74 PM

Additional Options

In this section, we will discuss the additional options to search data.

e Change the sort order: Click on acolumn header to change the sort order. By default,
the search results are sorted by the items most recently changed.

e View results by asset type: Click on a tab to filter the list by asset type.

e View item details: Click on an item to open the details page.
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29.VersionOne — Conversation

Conversation is one of the important features of VersionOne. It connects all members,
stakeholders and others to actively participate and collaborate.

Access and Participate

In this section, we will discuss how to access and participate in a conversation.

e Conversation occurs at the left side of each backlog item and defect.
e It appears in the Team Room and the Planning Room.
e Conversation can be accessed through the Collaboration tab as well.

e For starting and replying in a conversation, a user can enter the message in the left
side of the conversation box.

e To mention the team members in a conversation, type the first 3 characters of the
name, it displays all the matched names.

e Select the name. A user can select multiple team members one by one.
e Once the selection is done, click on Share to start a conversation.

e If the email notification is enabled in preferences, all added members will get an email
for the conversation. They will receive the email if any other member
comments/replies to the same conversation.

Following screenshot displays how to use conversations

7 secis B o - 4 Be—————

< C | & Secure | httpsy//wwwi3wlhost.com,T Default.aspxime Prim acklogPageBifaat-na 3 T 0

log tem B-01019

Conversations Sample: Enter RMA

1 Tasks 5 Tests 4 Downstream Dependencies 1  BacklogGoals 1 Links 0 Attachments 0
e PROJECT BACKLOG GRE
Samplo: Reloase 10 £ Cgdor Managomaont
| SPRINT PORTROLIG ITEM
Samplo; Month C 51 Halt
Cancel A
| TEAM OWNERS
Sampla: Toam A Sampio: Tammy Coder
STATUS FRICRITY TASK STATUS SUMMARY
-

In Progress High
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30.VersionOne — Collaboration

In this chapter, we will learn how collaboration takes place with VersionOne. As soon as
sprint/project team is formatted, they can utilize the collaboration tools to keep update and
track of sprint/project.

Q

Portfolio Release

Backlog

& %
v 125055 p P [ v

Order * Title ] Owmer Priority  Estimate Pts. Project “

1 [ Sample: Enter RMA B01010  Sample: Tammy Coder High 200 Sample: Release 1.0 m
2 [™ Sample: Inventory Levels Off in Warehouse D-01001  Sample: Alfred Smith Medum 100 Sample: Release 1.0 Edit v

[ Sample: Add Shipping Notes B-01020  Sample: Andre Agile High 5.00 Sample: Release 1.0 Edit v
a I'7 Sample: View Daily Call Count 801021  Sample: Alfred Smith Medium 500 Sample: Release 1.0 Edit v
5 [ Sample: Hold Order B0W22  Sample: Danny Developer High 2.00 Sample: Release 1.0 Edit v
6 ™ Sample: Pick Lists Reversed D-01002  Sample: Andre Agite Medium 2,00 Sample: Release 1.0 Edit v
7 [*7 Sample: Update RMA B-01023  Sample: Danny Developer Medium 200 Sample: Release 1.0 Edit +
8 [™ Sample: Export Missing ID Column D-01003  Sample: Andre Agile Medium 2.0 Sample: Release 1.0 Edit v
9 [*7 Sample: Multiple Ship-To's B-01024  Sample: Danny Developer High 5.00 Sample: Release 1.0 Edit v
10 %7 Sample: Calculate Tax 801025  Sample: Danny Developer High 5.00 Sample: Release 1.0 Edit ~

s el boledin D b i s i B-01026 High 200 Samole: Release 10 Edit v ~

To access the collaboration tools, click on the Collaboration symbol present at the side menu
bar as shown below:

A user can see the different communities at the left side along with where they are members
of and conversation is another tool in collaboration.

Community

Community stands for VersionOne community. All members of VersionOne are part of this.
They can access articles, blog or other important details here.

e A Topic is an article content within a community. Topics contain agreements, best
practices and documents that promote the Agile.

e Toview a topic, select the community present at the left side under Community section.

e Click on View to view one of the topics with all its details. Consider the following
screenshot to understand the step:
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i Cotasorsion P S Bt — |

€« C | @ Secure | https//www53.v1host.com/T fault.a tions8ust ty:301 % o

A AR Q o % e 0O

Portiolio Product Release Team Reports

Agile at Scale
Ashish Anand

Create and evolve agie best practices at the enterprise level

New Topic

Distributed Development Portfollo Levels
Wo use the following functional hierarchy as defined by the Portfolio ftem Type
0 Comments 0 Comments
All Conversations
Subscriptions Portfolio Management Product Roadmap

1gRoom

0 Comments
Find more people 1o follow
: = P Release Planning
ttps C aspx?m nversa © -

e Once the details of the topic displays, double-click anywhere in the content or click on
the edit symbol at the top right to start editing the content. After editing click on Save
button. User even can edit title of the content.

e At the bottom of the content, a user can attach paperwork by clicking on the Add
Attachment button. The max file size is 4 MB.

e A user can start a conversation under the conversation section.

The following screenshot displays how to work with content:

7 Cotooorsion = R ———

“ C | @ Secure | https//wwwS3.v1host.com/T efault.aspxr stions&strea ty:3018&t T v (4]

Group Communication: Siack
Find more people 1o follow In acdition to enabling team communication, Slack provides an instantly searchable record of all conversation as well 3s a way to share files, articles, links, etc.
It allows us to communicate from our computer and our smartphone. In addtion it integrates with many of the tocls we use on a day to day basis.

From a technical standpoint, we generally use tools that are hosted in the cloud; this way we don't have to deal with complicated networking and VPNs, That
being said, we also use cn-premise tools for the more “set it and forget it” tasks.

Version Control & Soyrce Code Mat: GRHUD -

@ ‘ Cancel
'

Conversations

e A user can even delete a topic with the required permission.

e To delete a topic, click on View to expand the topic content.
e At the top right, the delete symbol is present, click there as shown below:
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[ Cotteboration \_r- -~ -
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from our computer and our smartphone. In addeion it ntogrates with mary of the 1008 we Lse on a day 1o day basis.

From a tochnical standpoint. wo gencrally uso tools that are hosted in the cloud; this way wo don't have to deal with compiicated networking and VPNs. That being aid, we also use on-
Find moro people to follow promise took fof the more “sot #t and forgat " tasks.

e It opens the Delete Confirmation pop-up.

¢ When a user clicks on Delete, it deletes the topic.

The following screenshot displays the delete pop-up:

/[l Cotsboration x W

€ C | 8 Secure | https//www53.v1host.com/T

Are you sure you want to delete this
Topic? All associated content will be
lost

‘ Cancel
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31.VersionOne — Notification

Notification is subscription based. Subscription allows controlling the types of notifications a
user receives. It is based on the event types that a user subscribes to. For example, if a user
wants to know when a work item is assigned to him, he can set up a subscription to notify.
User can also subscribe when a story is closed or even when the status of a defect changes.
This way, a user can keep track of the things.

Subscription

To get a notification, a user needs to subscribe to the notification service first. Until it is not
subscribed, a user cannot receive any notification. In this section, we will discuss how to

subscribe for a specific notification.

e Toview the user’s subscription for notification, go to My Home -> Subscription as shown

below:
T ot Y — e = =]

ttps://www53.v1host.com/T fault X « [+
Q o %20
TeamRooms PlanningRooms Reports

ToamRooms PlanningRooms

My Dashboard

Timoshoot

oint them at whiteboards during tokcontorences, This allows everyone to

th 9ood audio and video. This has made 3 big Giferance, Not only 6o we

a5 woll 35 & way 10 share los, artickos, inks, otc. It Siows Us 10 ComMUNICate

cay

e In the My Subscription page, a user can see the subscriptions made by him.

e In the Notification Types, a user can see all type of notification that can be subscribed
for.
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To subscribe for a notification, click on the Subscribe button present at the

as shown below:

/ B Subseripticns

<« C | & Secure
RSS Feed

My Subscriptions

Title Description

hittps:/www53.vlhest.com,TC

q +30f3 p M

Backlog close
Watching Sample: Order Numbser Not Found (AT-01042) Test Changed

Watching Sample: Stora Credit for all returns. (AT-01050)

Notification Types

B B Tite

r§ Backlog Group

Backlog ltem Closed

Tast Changed

Description

Notification created when a Backlog tem is closed.
Backlog ltem Created Notification created when a Backleg ftem is created.
Backlog ltem Deleted Notification created when a Backleg ltem is deleted.
Backlog ltem Owners Added MNotification created when a Member is assigned as an Owner of a Backlog hem
Backlog ltem Owners Removed Motification created when a Member Is removed as an Owner of a Backlog Item.
Backlog ltem Reopened Notification created when a Backlog ltem is reopened,
Backlog ltem Status Changed Notification created when the Status of a Backlog Item is changed.

Backlog ltem Team Changed Motification created when the Team of a Backleg ltem is changed.

Notification Type

Backlog Group Closed

VersionOne

right side

Edit ~
Edit

Edit

Subscribe
Subscribe
Subseribe
Subscribe
Subscribe
Subseribe
Subscribe

Subscribe

It opens a pop-up wherein, a user can enter Title, Description,
and Team to narrow down the subscription.

Now, click on the Subscribe button as shown below:

/ [ Subscriptions

<« C | @ Secure

*

https//www53.v1lhost.com/T

— |

logliem Closod

Fomats~ EH~

B I Vs L
i &

Notify me when this combination occurs.
(Any)
children

Project v | within this Project and all its

Owners: Any x igned as an Owner of a Backlog item

(Any)

Team v | Is assigned as the Team on a Backlog ltem
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Delete a Subscription

Whenever a user wants to stop receive any notification, he should delete the notification at
the subscription page. In this section, we will discuss how to delete a subscription.

e To delete a subscription, go to My Home -> Subscription
e At My Subscription, click on the Edit dropdown at the right side.

e Select Delete from the available options and it de-subscribe the notification as shown
in the screenshot below:

P P T —— - F=re?

C | @ Secure | https//www53.v1host.com, +4 D

RSS Feed R
o8 |My Subscriptions
(L] f AV
-n

Title Not v
8 Back Bac Edit ~
e Test Edit

Watching Sample: Store Credst fi Test Edit

Delete
Notification Types
A
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32.VersionOne — Estimably

Estimably is an estimation game. It is a cloud based estimation game that is used to play with
sprint team to estimate the backlog items collectively. It helps in estimation for both co-located
and remote team members. It works as group collaboration and combined with independent
voting. When the team reaches a decision, it can automatically update the backlog item’s

estimate.

[ Semple: Call Center Tear %

€ C | @ Secure | httpsy//wwwi3.vlhost.com/T o L+

w My Home search Q 2 0

S/e_;_mple:g_czil CenftngeaT_Room :_\ . - Somple: Monin € 7% \;6,;; 200 [¥]
. '*2; AA :'\&N/r‘ BB {‘nlng* BT {‘nlnr?" [=1:] Iﬁo NN I*‘o Te I%‘o w Toial 25 pis. "l"' ’ 2. g2 2. n .‘.= 2. 1 :.' 2. 11292

Backlog Storyboard Taskboard Testhoard List View Closed Conversations Scorecard Topics

Backlog ©

Sample: Month C 2nd Half

7 Sample: Delete RMA (2)

™ Sample: Partial Shipments Doubled (0.5)
7 Sample: Forgotten Passwords (5)
Sample: Hardening Sprint

7 Sample: Field Completion (5)

THE ESTIMATION Game

Spaint 8

7 Sample: Call Time Reporting (10}

7 Sample: Process Wizard (20)

7 Sample: User Interface Story
7 Sample: User Interface Story Sta rt 5 Game
7 Sample: User Interface Story-aa

7 Sample: User Interface Story-aa

Sample: Boris Defect (0.25) Estimabily i 8 cloud-based etimation FAME you can e
WiTh yOuT Team 1o Collaboratively esumate your Dackicg. -

Estimably can be accessedin the Team Room by navigating Product Planner -> Team Room.
Now, click on Estimably as shown in the screenshot below:

Start a Game

There are some basic rules to play the estimation game. In this section, we will discuss how
to start a game.

e Only the facilitator should start a game by clicking on the Start a Game button.

e The designated facilitator then communicates the URL and the Game ID to the
participants.

e The participants log in to the game using that information. When they do, they are
visible to the facilitator.

The following screenshot displays how to start a game:
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[/ [ Sample: Call Center Tean x (F=S| E= ==

&«

e [i Secure | https//www53.v1host.com/TCS08,/ TeamRoom.mvc/Shaw/1027 ‘.Q'I (ST +]

Cwtemes s Q@ L)
@ Sample: Call Center TeamRoom # . . q. \::ao;r; 200 —_— (o]

D)
Sample: AA  Sample: BB Sample: BT Sample: DD Sample: NN Sample: TC  Sample: W Total 25 pis. “"“ |'|‘f'||7,‘2” 11/2‘”1 |'|,'2‘3;2” ||‘42‘7,-2, u_fz‘ggz,

B Show Unestimated Only

Sample: Month C 2nd Half End Game
[ Sample: Delete RMA (2)
[ Sample: Partial Shipments Doubled (0.5)
[ Sample: Forgotten Passwords (5)
Sample: Hardening Sprint
[ Sample: Field Completion (5)
Sprint 8
[77 Sample: Call Time Reporting (10)

[ Sample: Process Wizard (20}
[ Sample: User Interface Story
[77 Sample: User Interface Story
[ Sample: User Interface Story-aa

[ Sample: User Interface Story-2a R Begin Round

™ Sample: Boris Defect (0.25)

¢ By navigating to URL, it asks details to join the game. Enter the name and the Game
ID and click on Join Game as shown below:

» C | @ Secure | https//estimably.com/#/

Join Game

Play the Game

Once the game is started, all team members can play their part by choosing the estimation
number. Here, facilitator plays an important role to start the round. Follow these steps to play
the game.

e The facilitator drags an un-estimated item from the Backlog panel into the game.

e Click on the Begin Round button; this allows all participants to see numbers to estimate
the item as shown below:
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| [ Sempte Call Center Tear x '. Estimabily x - - - . | locos] 23
& @ | & Secure | https://estimably.com/#/ga o (4]
W VERSIONONE
ff

HE ESTIMATION qg“e

Game ID: KXDJD Leave the Game

Current Estimation Item:
B-01047 Sample: User Interface Story

At this point, the Product Owner again describes the item and the acceptance criteria
to provide a good understanding. The Team Members can ask questions if any for more
clarity.

After that, the voting participants vote.

As the voting occurs, the facilitator can see who has voted. Each participant can see a
running total of the number of votes.

When all participants have voted, the facilitator ends the voting round, which presents
everyone the results as shown below:

< C | @ Secure | https//www53.v1host.com, a 4 (¢
A AR Q L)
Sample: Call Center TeamRoom # e v ] ey 1200 o
@ P & 5 p & @ @ ———— | 1033
) ) i 3 ( [ o
- \\’13. AA E;vn/!r 88 ﬂam;- oY @c oo )1/. NN \q;:t TC -\q‘m;{- w Totol 25 s | TIN NN N2172 1232 11/27)2 1/29/2

Storyboard  Taskboard  Testboard  List View Closed  Conversations  Activity Stream Scorecard  Topks
Backlog &

W VERSIONONE
- J
Sample: Month C 2nd Half m
1 Sample: Delete RMA (2) THE ESTMATION eGp
™ Sample: Partial Shipments Doubled (0.5) Game ID: KXDJD End Game
https://estimably.com/join/KXDJD

"7 Sample: Forgotten Passwords (5)
Sample: Hardening Sprint
Selected Estimation Item:

B-01047 Sample: User Interface Story

Sample: Field Completion (5)

Speint 8
=
7 Sample: Call Time Reporting (10)
I Sample: Process Wizard (20) Results:
[7 Sample: User Interface Story hish

[*7 Sample: User Interface Story
[*7 Sample: User Interface Story-aa

7 Sample: User Interface Story-aa

If there is agreement by all, then the facilitator simply submits the vote to save it to
that work item and select another to estimate.

If there is some variation in the voting, the team members can discuss their reasoning.
At this point, the facilitator can elect to run the vote again or can select a verbally

agreed-upon value to submit as the estimate.

As soon as facilitator clicks on submit to workitem, the value gets updated as
estimationinto backlog item.
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